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1 Welcome

This User Manual contains detailed information about the Health Financial Systems
cost report software.  This manual is for all users of our software, especially those
who prepare cost reports.  HFS is approved by the Center for Medicare and
Medicaid Studies (CMS) as an official vendor of eleven different cost report
software systems.  This manual is applicable to ten of those eleven subsystems:

CORF/CMHC (2088-17 & 2088-92) 

ESRD (265-11 & 265-94)

FQHC (224-14)

HHA (1728-20 & 1728-94) 

Home Office (287-22 & 287-05)

Hospice (1984-14 & 1984-99) 

Hospital (2552-10 & 2552-96)

OPO (265-94)

RHC (222-17 & 222-92) 

SNF (2540-10 & 2540-96)

This manual does not discuss the Interns & Residents Information System (IRIS)
program or the HCRIS Database.  There is a separate manual dedicated to the
IRIS software and HCRIS Database.

This manual is also intended for HFS clients who use our California cost report
systems, CHDR and LTCIR.  HFS is approved by the State of California, Health
Care Access and Information (HCAI) as an official vendor of the California
healthcare reporting software systems.  There are some differences between the
functions available in the California systems and the Medicare systems, but those
differences are relatively few and insignificant.  Such differences are identified, as
applicable, throughout this manual.

This manual is extensive and contains detailed descriptions of the software
functions, features and utilities.  Many topics include step-by-step instructions on
how to use the functions, features and utilities.

The software is a Windows based application and that means that those of you
who are familiar with how to use other Windows based applications will
immediately be able to begin using the software without reading this manual.

For those of you who are new to HFS cost report software products, we offer
these convenient resources to help you quickly learn how to use the software.

Getting Started
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See Installation chapter to learn to setup/
update the software.

Review What's New & Different

Work through Feature Tutorials to
familiarize yourself with the software.

Read Frequently Asked Questions on 
HFS website for answers to questions.

Learning More

Read about: Medicare Auditor;
Management Reports; PS&R; AAI; Batch
AAI; Data Extractor; Batch Data Extractor;
Batch Print; Batch Import; Batch Export.

Visit our website www.hfssoft.com.

Technical Support

Send an email: support@hfssoft.com

Call technical support: (888)216-6041

Version

This is version 5.0.9 of the help/user
manual.

 
The more you know about the software and its features, the easier your job
will be.  Once you start using our cost report software you will wonder how
you ever prepared a cost report without it.

1.1 Copyright

Health Financial Systems

Cost Report Software User Manual

Copyright 2025 
Health Financial Systems and International Micro Design, Inc.

https://hfssoft.com/webinars/tutorials/
http://www.hfssoft.com/iFrame/Support/iFAQ.aspx
mailto:support@hfssoft.com
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The UB-04 Data File [2025], is copyrighted by American Hospital Association (AHA),

Chicago, Illinois. No portion of the UB-04 Data File may be reproduced, stored in a retrieval

system, or transmitted, in any form or by any means, electronic, mechanical, photocopying,

recording, or otherwise, without prior express, written consent of AHA

1.2 Introduction

Since 1981, Health Financial Systems (HFS) has been developing and marketing
CMS approved Medicare cost report software.  HFS cost report software is used
by Medicare health care  providers, CPA firms and reimbursement consultants to
prepare and submit Medicare cost reports. HFS Medicare cost report software is
used to prepare more Medicare cost reports than any other cost report software,
making HFS the largest automated cost report software vendor in the United
States.

HFS software is used by more Medicare Administrative Contractors (MACs) and
Fiscal Intermediaries to accept and audit cost reports than any other cost report
software. Most likely, your FI/MAC uses HFS cost report software to process your
cost report.

Our users choose HFS software because of its quality, dependability, range of
feature, ease of use, and live customer support that is unmatched in the industry. 
We offer live technical support every hour of every day of the week. Our full-time
staff of support professionals have decades of experience with cost reports and
the cost report software.  We encourage every customers to email us at 
support@hfssoft.com. or call us at (888) 216-6041. The software is designed to
make your job easier.  If you are bogged down with a confusing cost report issue
or if you're not sure how to do something in the software, contact us.  Don't wait
until you are frustrated or discouraged.  Send us an e-mail or call us and we will be
able to answer your questions and resolve any problems you encounter.

At HFS, we make an extra effort to be responsive to the needs and desires of our
customers. Many of the features in our software were developed at your request
and some of them continue to evolve as a result of input from you.  If you have
ideas for enhancements or comments about any aspect of the software, please
share them with us.

Please use these convenient links to contact us:

request Information

HFS Sales representative

technical Support

We hope you enjoy using our software. On behalf of everyone here at HFS we
thank you for choosing our software and we look forward to a long working
relationship with you.

mailto:support@hfssoft.com
http://www.hfssoft.com/iFrame/Forms/iemailus.aspx?emailto=info@hfssoft.com
http://www.hfssoft.com/iFrame/Forms/iemailus.aspx?emailto=sales@hfssoft.com
http://www.hfssoft.com/iFrame/Forms/iemailus.aspx?emailto=support@hfssoft.com
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1.3 System Requirements

The minimum system requirements for the HFS 32-bit software include:

 1.5 GHz or higher - x86 or x64 compatible processor;

 1.5 gigabytes (GB) or more for 32-bit OS (Recommend 3GB or more);

 4 gigabytes (GB) or more for 64-bit OS (Recommend 8GB or more);

 1.5 gigabytes (GB) of free space;

 floppy, USB drives and/or CD/DVD writable;

 keyboard and mouse or some other compatible pointing device;

 1024x768 or higher resolution monitor (Recommend 1920x1080 at 100%);

 Microsoft Windows 8.1/10, or later operating systems;

 Internet Explorer 9.0 or later, 32-bit browser only. Internet functionality
requires Internet access (fees may apply);

 Microsoft XML Core Services (MSXML) version 3.0 and 6.0;

 Adobe Reader version 8 or higher. 

For a complete listing of all system requirements click this link to be taken directly
to the .pdf: https://www.hfssoft.com/doc/SystemRequirements.pdf.

Many HFS customers install and use the software in non-Windows environments
(e.g., Citrix).  The software works in various types of network operating
environments, but it is developed in and for Microsoft Windows-based personal
computers.  HFS cost report software is not compatible with Apple computers,
although some HFS customers run the software on their Apple computers by
installing a virtual instance of a Windows operating system and then they run the
cost report software in the virtual instance of Windows.

1.4 What's New & Different?

This section describes some of the main differences between the new 32-bit
software and previous versions of HFS cost report software. Every attempt has
been made to make the software look and feel like previous versions, while adding
enhancements to make the software more flexible, more powerful and easier to
use.  By "New", we mean relatively new, not necessarily new this year.

https://www.hfssoft.com/doc/SystemRequirements.pdf
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SaFE Server

When you create an ECR file you now have the option of submitting your cost
report and your ECR files to our SaFE server. We will run your file through an
automated version of an acceptance review. Our web database will import your
electronic submission and give you a report. This process validates the encryption
code on both the EC and PI files. Next, we check the data in the EC file for validity.
The EC file is converted to an HFS file and calculated. All CMS edits and the
settlement calculation is checked and compared. Finally, all data in the EC file are
compared with the values created in the HFS data file. We cannot guarantee that
this check will catch everything but it’s a great review. At this point, the pre-scan is
in no way associated with the MAC’s Acceptability process and has no way of
checking signatures or data filed outside of the cost report.

We will keep your data and store it under your account. You will have access to
your data. We have also expand our New Report Wizard feature to look at your
web account for prior year data to start your next year’s cost report. Consider
SaFE a great back up location of your data. Your file will not be shared with
anyone outside of HFS. Your cost report will only become public data when the
MAC submits your data to the CMS HCRIS database and CMS releases that data
to the public. We are testing this process to see if it would be useful to MACs. At
this point we will not send your data to the MACs. If we are successful in
automating this process and the MACs are interested in the pre-scan automation,
we will notify you and ask permission to share your data with your MAC.

New Data File Format

With the introduction of the 2552-10, 2540-10, 265-11, 1984-14, 1728-94, 222-92
and 224-14 cost report systems HFS introduced a new type of data file that
replaced the .mcr file we used for many years.  The .mcr data files were indexed
data files and were susceptible to corruption anytime their indexes were damaged.
 Our software included the Restore/Reorganize utility to repair damaged files and
rebuild their indexes.  In the new cost report systems HFS uses XML data files. 
These new data files are .mcrx files.  The .mcrx files are not susceptible to
corruption or data loss. We introduced this new data file format in 2010 and there
has never been a single instance of a .mcrx file that was corrupted.  Bad or
missing data file records are no longer an issue.

Long File Names

You are no longer limited to an eight digit file name. HFS still reserves the
extension of your file name but you may use of the other 256 characters.

Open Multiple Files

You can open two or more cost reports in one session of the HFS software. You
can switch between open cost reports by clicking on the drop down box in the
bottom right of your screen.
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Check for Updates

The system is Internet accessible. You will select the Check for Updates option
and the system will see if there are any updates you need to download. If updates
are available, you will be prompted to install the updates.  The update installer will
shut down the software, download the update files, install the updates and restart
your software. When the program restarts the opening screen will display the
version notes for the update(s) that were just installed.

Net Sync for Multi-User Sites

This feature replaces our Version Checker feature. The feature runs faster and
uses a more reliable installation process.

Task Pane

The Task Pane is located on the right-hand side of the main user interface screen.
The purpose of the Task Pane is to provide an easy access location for you to
perform common tasks, such as opening or creating files, reviewing edits, and
checking for software updates or news from the HFS web site.

Customizable Tool Bar

The toolbar is not new to the software, but the ability to customize it to suit your
needs is. Virtually all commands that appear on the menu are accessible through
the tool bar. Items on the tool bar may be added or removed, and even the order
of those items can be customized. This is great for including only those items you
need, while hiding those you don’t need. You can even hide the entire toolbar if you
prefer not to see it.

Software Preferences and Options

The Options screen has been reformatted to show you all of the available options
in a “tree” structure, rather than in tabbed format. Options for all features are
located in this one place so you always know where to find them. In addition to the
format change, new options have been added, such as the Headlines option. To
explore these options, click the Options menu and then select Preferences.

Improved Cut, Copy and Paste

These features perform like other Windows programs.   If you are pasting multiple
cells of data into your report you can just click the first cell and the system will
paste all of the information.  Also, if the source of your data is formatted with
commas or decimal places the system will automatically convert it to our screen
format with no commas and no decimal places.

Add and Delete Line Buttons
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These buttons detect if the worksheet is appropriate for adding or deleting cost
centers or lines. While viewing some forms you can add or delete lines.  You can
also add lines to the adjustment forms and the balance sheet form.

 

2 Install & Update the Software

In this section you will learn how to install the cost report software and how to
perform periodic updates in the future.

See also:

Installation

Check for Updates

Network Synchronization

Uninstall

 

2.1 Installation

1. To install the software, you must have administrative rights on your
computer.

2. Open your Internet browser and go to our website www.hfssoft.com. At the
top of the main page you will see a series of links. Select the “Downloads”
link.

Figure 1 - Downloads link on main page

3. You will be prompted to enter your username and password.
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Figure 2 - Sign In 

4. If you cannot remember your username, click the appropriate link, and enter
your email address to have your username sent to you. If you forgot your
password, click on the link to have an email sent to you that will enable you
to reset your password.

5. If you are a new user and do not have a username or password, click on
the “Join Us” link to register as a new user and obtain a username and
password.

6. After you enter your username and password click the Submit button. After
your username and password are verified you will see the Download
Center. 

Figure 3- Download Center

7. The software products that you have licensed will display a button
with the caption “Full Download”. Other software products will only
be available to download as demos. Find the software product you
purchased and click the “Full Download” button. Respond to the
various prompts you will see during the process.  By default, the
setup program will install the software to C:\MCRIF32, unless you
specify a different location. The program may be installed on and
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run from a network drive, but we do not recommend it because the
software generally runs faster from your hard drive.

8. After the installation is complete, you can start the software by
double clicking on the blue/green HFS desktop icon.

Figure 4 - HFS Desktop Icon

9. If the software does not start when you click the blue/green
icon, you may need to run the program as an administrator.
Depending on your operating system, right click on the HFS
desktop icon and select “Properties” then chose “Run as
Administrator” or “Run in
Administrative Mode”. The software should startup normally.

10. In the future you will receive email notification of any updates to your
software. When you
receive notice of an update, perform the Check for Updates procedure by
selecting “Check for Updates” from the Help menu in the software.  In
addition to this, when you open your HFS software, if an update is available,
an update bar will appear at the bottom of your software alerting you to
update.

Figure 5 - Check for Updates

11.You can access our user manual and the CMS cost report
instructions from within the software while working on a cost report
by clicking on Help and selecting either CMS Instructions or HFS
User Manual - Contents. Clicking on Contents will open the online
user manual. The user manual help can also be accessed by
clicking on the Help topic in the Task Pane. Press F1 while you are
working on your cost report to open the CMS Instructions for the
worksheet you are currently working on.

12.You can contact our customer support team Monday through Friday
(excluding holidays) between the hours of 5:00 a.m. (EST) until 5:00
p.m. (PST) by calling (888) 216-6041 or by email
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(support@hfssoft.com). We encourage you to call and ask
questions. Using the software should be a pleasant experience. If
you cannot figure something out, just call us. We probably know the
answers to your questions. We welcome your questions and we
appreciate any comments and feedback. You can submit comments
and feedback by clicking on “Submit Feedback” under Help in the
Task Pane.)

2.2 Check for Updates

The importance of periodically updating your cost report software cannot be
sufficiently emphasized.  CMS regularly publishes instructions to cost report
vendors regarding software changes.  These changes do not occur at predictable
intervals. What is predictable is that mandatory changes will always happen and
you may or may not be aware of them.  It is a certainty that if you don't update
your software, your cost report will not reflect recent changes.  Depending on the
seriousness of the changes or of the impact the changes have on the cost report,
your cost report may be incomplete and incorrect because you used outdated
software to prepare your report.  When you submit your cost report to your FI/
MAC, your cost report may be rejected and the MAC may withhold Medicare
payments to the provider, and if the problem persists, the MAC may treat any
payments to the provider during the cost report period as over payments and
require the provider pay back all payments for the year.

You can easily prevent this from happening if you check for updates when you
have not used the software for a few months, or even weeks.  You should also
check for updates before you finalize and submit your completed cost report to
your MAC.  If there are updates available, install them.  Don't put it off until later.
Install the updates, restart the software, open your cost report and recalculate it to
see if there are any new edits or any unexpected reimbursement impacts. Then
you can be confident that the cost report you submit was prepared using the most
current available version of the program.

The software is designed to communicate with our servers and determine if you
need to download and install updates. You do not have to visit the HFS website to
perform updates. Registered users will receive periodic email notifications of
updates. The software can be updated while using the cost report software.  On
the Help menu, select Check for Updates. You will be prompted to enter your
username and password.  Enter your username and password and click OK.  The
Updates Installer dialog box will open after your username and password are
verified.
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If there are any updates to download they will be displayed in the Available
Updates section.  Click Install to download and install the available update(s). The
update installer will ask your permission to close the cost report software.  Click 
OK to close the cost report software and proceed to download and install the
updates. The installer program will download the updates.  After the download is
complete, the install program will start and the updates will be installed.  When the
update installer is finished click Close. The cost report software will re-start
automatically and you may resume working on your cost report.

 

2.3 Network Synchronization - for Multi User Sites

Network Synchronization is designed for use by clients with multiple users.  This
feature will allow one computer or workstation to be updated and all other
computers will be updated automatically, based on the software installed on the
administrator's computer.  This feature assumes that there will be an
“administrator” responsible for keeping the designated workstation up to date.  The
administrator will install the latest software to a local hard drive or network
location.  When the update or install is complete, the administrator must "publish"
files to a shared network location that will update the rest of the workstations with
the updates installed by the administrator.  To start the Netsync program, click the
Windows Start button.  Select All Programs and point to Health Financial
Systems and select HFS Admin Suite.   You can also locate the HFS Admin
Suite.exe file in the C:\MCRIF32 directory and establish an icon on yout desktop.

 

If you have done this before, you will see the Date of Last Publication.  You may
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optionally enter a description in the Note to Users box.  Your users will see this
note when they synchronize their software.  The New Publication Date will default
to today’s date.  This field is important because it is used as a control mechanism
to help the client machine recognize new network content.  If the date is not what
you want, enter the date manually, or use the pop-up calendar.  Click the Publish
for Network Synchronization button to create the files your users need to
synchronize their software to the network.  Because the new publication data will
overwrite any existing publication data you will be asked to confirm that you want
to publish new files.  Below is the screen of the Admin Suite.

62BTwo files will be created: Netsync.exe and Netsync.xml.  These files will be copied
to a network location.  The network folder must be visible to your users through a
mapped drive. Next setup the  other computers to “Synchronize” with this network
location.  The other computers must have the cost report software installed.  Open
the software.  On the Options menu select Preferences, then click Setup and
choose Environment.

Specify the synchronization folder in the Synchronize Folder box.  This must be
the folder where the Netsync files were copied. You may choose how the software
synchronizes with the network.  The Synchronize on Start Up option will cause
the software to check the network for the latest updated software each time the
software starts.  If you choose Synchronize on Demand, the software can be
manually synchronized by selecting Synchronize on Demand on the Help menu. 66BIf
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there are updates available, the software will close and the updater program will
run.  After the update is complete, your software is ready to use.

 

2.4 Uninstall the Software

You can uninstall the software by clicking the Windows Start button and selecting
Control Panel. Windows XP users will then select Add/Remove Programs.  Vista
and Windows 7 users will select Programs.  Windows will show you a list of all
currently installed programs.  Scroll down the list for MCRIF32 preceded by a
yellow HFS Icon.  You may also find entries for the various cost report modules,
such as 2552-10 or 287-22 or 2540-10.  Select the program you want to uninstall
and click Change/Remove or Uninstall.

 

3 The User Interface

Start the HFS Medicare cost report software by double clicking on the yellow HFS
icon on your desktop (Medicare Cost Report Interface 32).  Alternatively, you can
start the software by clicking the Windows Start button, point to [All] Programs
and Health Financial Systems then select Medicare Cost Report Interface 32.
The cost report program will start and you will see the User Interface screen.

 

See also:
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 Task Pane

 File Information

 Calculate Indicator

 Data File Drop Down Box

 Tool Bar

 

3.1 Task Pane

The Task Pane is located on the right-hand side of the screen.

 

The Task Pane provides easy access to information and common tasks, such as
opening or creating files, reviewing edits, and checking for and downloading
software updates from the HFS website.  By default, the Task Pane is displayed
each time you start the software. However, you can close the Task Pane by
clicking the Close (X) button in the upper right corner. If you don't want the Task
Pane to show each time you start the program,  remove the check mark from the 
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Show on Startup check box in the bottom left hand corner.  The following options
are available in the Task Pane:

Opening an Existing Cost Report File

Open a New Cost Report

Import an ECR file

Check for Updates

HFS Cost Report Help

Submit Feedback

If you click the Down Arrow (? )  (located to the left of the Close (X) button) the
menu options shown below will be displayed.

 

 

Click File Operations to return to the initial Task Pane screen. You can set up
links or references to certain websites that may help you with your cost-report
preparation.

Click Headlines to display links to web addresses.  Click on the hyperlinks to open
the corresponding websites in an internet browser window. The Edits and Forms
options are only available when you are in a cost report.  The Edits pane shows
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the edits from the most recent calculate.

Click any of the form sets available (such as 2552-10, 287-22, and so on) to open
the specific Task Pane view for the selected cost report form set.

See also:        Task Pane Options

 

3.2 File Information

After you open a cost report, the screen will display information about the data file
you opened.

The top left of the screen will show you the provider number and name.  

The top right of the screen will show you the fiscal period for this report.

The directory path and file name of the open cost report is displayed on the lower
right border of the screen, as is the CMS form number for the type of cost report
you are working on.

 

3.3 Calculate Indicator

In the top right of the screen is a calculate indicator.

     

Any data entry or edits on a cost report form will be interpreted by the program as
a change to your cost report file and the Calculate box will show “Not Calculated” 
The button will turn to “Calculated” after you calculate the cost report. Click the 
Calculate button or, on the Tools menu select Calculate. Clicking on the
Calculate box will not calculate your cost report.

A yellow calculated icon means the file is calculated but has level I edit(s).  
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VACRS (DRG-796) calculate indicators relate to the State of Virginia worksheets.
These indicators will only show if 'Virginia VACRS is selected on worksheet S-2,
Part IX line 10.  

 

3.4 Data File List Box

The Data File list is box located on the lower right edge of your screen, to the
immediate left of the text box that displays the CMS form set number.

The Data File list box displays the path and file name of the open cost report data
file.  If you have more than one file open, you can click on the down arrow and
select another open cost report.  You can have two or more cost reports open at
the same time.  The Data File list box will display the name of the cost report file
that presently has the "focus."   For example, if two cost reports are open, and one
form is open in each cost report, and both forms are displayed by splitting the
screen horizontally, the Data File list box will display the name of the cost report
file that corresponds to the form that the cursor is active within.

 

3.5 Tool Bar

By default, the system displays the following buttons on the Tool Bar.

To customize the Tool Bar, open the Options menu, click Preferences and select
Setup Tool Bar.

Note: Some buttons are not active unless a cost report file is open.

Starting from the left hand side of the Tool Bar and working to the right, the
following are the default items on the Tool Bar.

Worksheet List Box
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You can enter the name of a worksheet (A, A-6, B-1, etc.) in this box.  After you
type the name of the worksheet and press ENTER, the worksheet will open on
your screen.  If you enter an invalid worksheet name, the system will open the 
Open Forms dialog box and highlight the name of the worksheet in the list that is
most similar to worksheet name you typed. Select a worksheet from the list to
open the worksheet.

This box remembers all the forms that you opened during the current session.  If
you close a form you can re-open it by clicking the down arrow and selecting it
from the list.

New, Open, Close
Click to create a new file, open an existing file or close the current
file. HFS saves data as you enter it so when you close a cost
report all data is saved. There isn't a separate "Save" command.

Calculate
Click the Calculate button to calculate the cost report. After the
report is calculated, all edits will be displayed in the Calculation
Edits dialog box and all calculated changes will be reflected
throughout the cost report.

Print Form, Preview Form
Click these buttons to quickly Print or Print Preview the active
worksheet. The active worksheet is the worksheet visible on your
screen. When you click these buttons, the form is instantly printed
or previewed.  The usual preliminary option dialog boxes are
skipped.

Cut, Copy, Paste
These buttons perform the Cut, Copy, and Paste commands. 
Use them to manipulate data within in worksheet or between
worksheets and applications.

Open Form
Click to open the Open Forms dialog box.

Add Lines, Delete Lines
Click these buttons to add or delete lines.  When you click either
button the Cost Center and Statistics Setup dialog box will
open, enabling you to add and delete lines.  You can only add and
delete lines to/from certain worksheets.
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Email File
Click this button to send a cost report file to HFS Support for help.

 

See also:        Toolbar Options

 

4 The Main Menu

In the upper left region of the cost report user interface screen you will see a
standard Windows menu bar, with various drop-down menu commands.

See also:

 File Menu

 Edit Menu

 Forms Menu

 Options Menu

 Tools Menu

 View Menu

 Window Menu

 Help Menu

 

4.1 The File Menu

The File menu contains various commands:

New

New Report Wizard

Open

Recent Files

Save As

Close

Close All

Backup

Batch

SaFE Download

Print

Import

Export

Exit
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Each of these commands are discussed in the topics that follow this section.

4.1.1 New File

Click New to open the New File dialog box.  This is where you enter the details to
create a new cost report file. The process is exactly the same as previously
described when creating a new file from the Task Pane.

1.     In the File Type list box, select the type of cost report file you want to
create.

2.     In the File Name text box, enter a file name for the new cost report.  Do not
accept the default name, which is "New", or "New01", etc...  Give your file a
meaningful name that will enable you to identify the  contents of the file.

3.     Click the Use Template check box is you want to use a template file to
populate your cost report with data as it is created.

4.     If you selected the Use Template option, click the Open Folder or Browse
button and find the file you want to use as the template and select it.

5.     When finished entering information in the dialog box, click OK to create and
open your new cost report file.

When the file creation process is finished, your screen will sort of go "blank." 
However, if you look closely, you will notice significant changes occurred in the
main User Interface window after you created the new file.  There will be screen
elements that display information about your new cost report file.

The file name will appear in the lower right edge of the window.

The cost report period beginning and ending dates are visible (if present in the
template file) in the upper right portion of the screen.
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The provider name is visible beneath the menu bar (if present in the template
file).

The provider number is visible beneath the menu bar (if present in the template
file), and

Some of the Toolbar buttons will be enabled because your cost report is open.
 

Before any files are opened, the toolbar has limited functionality.  It looks like the
example below.

When a cost report file is open, the tool bar changes and looks like this:

If you open worksheets the other buttons on the toolbar will be enabled.  The Add
Lines and Delete Lines buttons are enabled only when you open a worksheet that
you can modify by adding and deleting lines.

See also:        Opening a New Cost Report

 

4.1.2 New Report Wizard

The New Report Wizard is used to help get your current year cost report started
by using a prior year cost report. The idea is to transfer prior year data that does
not typically change year to year to the new cost report you are creating.  

Currently, the only systems available for the New Report wizard are 2552-10,
2540-10, 1728-94, 1728-20, 287-22, 287-05, CHDRX and LTCIRX. 

After clicking on File | New Report Wizard you will see a pop-up screen with
different options on where your prior year report can be found or not having a prior
year report. 
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The current options are-
SaFE 

This option is for users who have previously submitted their cost report
to our SaFE website.  If you select this option, you will be prompted to
log in with your HFS credentials.  Once logged in all cost reports tied to
your user account in SaFE will be shown.  You can select a report from
this list and click the Next button. This next screen allows for the new
fiscal year to be entered and also provides a list of check boxes asking
which information you would like to have brought into the new cost
report from the prior year cost report, select Next to go to the next
screen.  This final screen asks where you want this cost report file to
be saved at and what do you want the file to be named. click Finished
when done.  

Local Computer or Network
If your prior year cost report or EC file is located on your computer or
facility's shared network drive you would select this option and click
Next. The Select local file screen allows you to browse and select the
prior year file.  Once you have the file in the Template Report text box,
click the Next button. This next screen allows for the new fiscal year to
be entered and also provides a list of check boxes asking which
information you would like to have brought into the new cost report from
the prior year cost report, select Next to go to the next screen.  This
final screen asks where you want this cost report file to be saved at
and what do you want the file to be named. click Finished when done.  

I don't have a previous report 
No prior year report, that is OK select this option to walk through
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setting up a new cost report and select the Next button.  This screen
presents a drop down box where you can select the type of cost report
you want to create, then click Next.  On the Cost Report Information
screen you will input the Fiscal year and basic data about the facility. 
Once you have filled in at least the required data (notated by *) click the
Next button. This final screen asks where you want this cost report file
to be saved at and what do you want the file to be named. click
Finished when done.   

There is another option but is not currently available-
HCRIS

This option will allow HCRIS users to access the HFS HCRIS online
Database to pull and use files from as templates to start their new cost
report file. 

4.1.3 Open File

Click Open to open an existing cost report. The process is exactly the same as
previously described when opening an existing cost report from the Task Pane.

Note: You can open more than one file at a time. If you have multiple files open,
you can toggle between each one by clicking on the down arrow (? ) in the
bottom-right corner of the screen.

 

See also:        Recent Files
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4.1.4 Recent Files

Click Recent Files to display up to 35 previously opened files. Clicking on any file
displayed will automatically open that file.

Note: You can choose how many recent files to display in the Preferences screen.

 

4.1.5 Save As

Click the Save As command to save the open cost report file to a new location or
to the same location but with a different file name. In addition, you can choose to
save all or some of the files that are associated with the cost report file.

Note: When you close a worksheet or close your cost report, all data is
automatically saved.

 

4.1.6 Close & Close All

Select the Close command save and close the cost report that is currently active
on the screen. If more than one cost report is open, select the Close All
command, and all the files will be closed.

Note: Any information entered in the cost report file is automatically saved when
you close the file.
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4.1.7 Backup

Select Backup to open the Backup Locations dialog box. Click the Add button to
add backup locations. Click the Include Other Files check box to include
associated files in the back up.  Click the check boxes to include or exclude the
various associated files.

The backup location you specify is the destination or output folder for the backed-
up files.  The source directory cannot be modified.  The source directory is the
folder in which the currently open cost report is stored.  You can specify multiple
output directories.

 

4.1.8 Batch

The Batch feature includes several utilities that process multiple files:

 Batch Print

 Batch Import

 Batch Export

 Batch Data Extractor

 Batch AAI

The Batch Print feature is discussed in the section that follows this topic.  Batch
Import, Batch Data Extractor and Batch AAI are each covered in their own topic
sections in the chapters that follow.  Batch Export is a feature used by FI/MACs to
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export HCRIS files in a batch process.  The HCRIS batch topic is not discussed in
this manual.

 

4.1.9 SaFE Download

SaFE Download is a utility feature that allows users to easily access their SaFE
submissions without having to go to our website, https://safe.hfssoft.com/. The
utility requires you to log in with your username and password.  

Once logged in you are able to see what files have been uploaded and stored on
SaFE.  The status of the Pre-Acceptance report is displayed showing which files
have passed/failed.  Filters allow you to drill down to a specific cost report file by
the report type, provider number, FY and date the file was stored. From here files
can be downloaded to your computer and accessed anytime. 

https://safe.hfssoft.com/
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4.1.10 Print

Refer to the Printing the Report section in chapter 4 of this manual.
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4.1.10.1 Batch Print

The Batch Print feature allows you to print selected worksheets and reports from
multiple cost report files.  From the File menu, select Batch, and then click Batch
Print.  You will be prompted to select the type of cost reports you want to print.

Select the type of cost reports from the Report Type list, then click OK.

In the Batch Print Options dialog box click to select the worksheets and reports
you want to print, or select the option to Select All Forms.  After you make your
selections,  click Next.
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Click to select which reports to print and if you want to calculate the reports before
you print from them.  When finished, click Next.

 

You can either specify certain files to print from or choose folders containing
reports to print from.  If you identify particular files to print, you can add and
remove  files from the list by clicking Add and Remove.  Click Next when you're
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finished identifying the files or folders to print from.

Next, you may select the option to print to PDF file, and if you do, when the file is
created, you can choose to:

Always prompt for a file name

Only prompt if file exists

Always overwrite an existing file

Skip printing if the file already exists.

Click the Printer Setup button to configure your printer. Click Next to proceed.  If
you chose the PDF option, you will be prompted to enter the destination folder. 
Click Finish to print the batch of worksheets and reports.

4.1.11 Import ECR Files

This option will import an electronic cost report file. You can also import by going
to the File menu and selecting Import. The import files dialog box allows you to
select the electronic cost report file you want to import. Change the Files of Type
box to show the type of ECR file you want to import. When you import an ECR file
the software creates an .mcr or .mcrx file that is an exact duplicate of the  cost
report file from which the ECR file was originally exported.
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After you click on the Open button, the ECR file will be imported, and cost report
file will be created.  The new cost report file will be calculated as part of the import
procedure.  You will see the Import Completed dialog box depicted below when
the process is finished.
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The dialog box displays information regarding the results of the ECR import and
cost report file creation.  There are five tabs in the dialog box.  Each tab will
display different information regarding the ECR import.  The above example
depicts the information shown when you click on the Import Errors tab.  In the
example below, the Settings tab is selected.
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The Settings tab displays the name of the ECR file, name of the PI file and the
name of the cost report file.

The Notes tab (shown below) shows the name of the imported file, the name of
the new cost report created by the import process, the results of the encryption
code verification, the number of ECR records imported, any errors encountered
during import and the results of the first calculate performed on the new file.
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The Edits tab (above) displays detailed information derived from the first calculate
performed on the new cost report file.  The information displayed is the same as
the information displayed when a cost report is calculated.

The Import Summary tab (below) displays additional detailed information about
the data imported from the EC file, the provider identified in the EC file, the
software vendor and other relevant information.
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See also:

 Batch Import ECR Files

 700 Series Reports

4.1.11.1 700 Series Reports

A series of worksheets (called the 700 series) are created during the ECR import
process. You can locate these by clicking on Forms and Open and then scrolling
to the bottom of the list of worksheets. The 700 series of worksheets shows
pertinent data from the ECR file, compares it to the same data in the newly
created cost report file and then displays any differences. Below are examples of
the 701 and 702 worksheets that relate to Worksheets S and S-3.
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The example below contains a list of all 700 series reports generated during the
ECR import process. (Yellow highlighting added for emphasis.)  Please note that
with the 2552-10 system, we combined the 700 series into one report - 700
Report.
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4.1.11.2 Import Batch ECR

In addition to being able to import individual ECR files, importing from the File
menu gives you the ability to import multiple ECR files at once.

The Import Batch dialog box provides the following options:

Import all ECR files (regardless of type) from a folder;

Import certain selected ECR files;

Choose the folder in which you wish to save the newly created MCR files.

4.1.12 Export ECR

The Export ECR File function creates an EC file, a Print Image file and an
encrypted Settlement/Signature Page.  The Settlement/Signature Page is a PDF
file and is printed during the ECR Export process.  The EC and Print Image files
are submitted to your MAC are collectively referred to as the ECR file.  The PDF
of the signature page is not submitted.  The signed printed copy of the signature
page is submitted with your ECR files.  

With cost reports ending on or after 12/31/2017 CMS has initiated electronic
signature to the EC export.  You are still allowed to have a wet signature or can
electronically sign.  You will submit the EC file, the PI (Print Image) file along with
the signature page.

To create a set of ECR files, open the File menu and click Export and select ECR
File. This function is discussed in greater detail in Chapter 6.
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See also:

Submit Finished Cost Report

ECR File Names

How to Create ECR Files

 

4.1.13 Exit

Selecting Exit from the File menu closes the cost report software. Any cost report
currently open is automatically saved and closed.

 

4.2 The Edit Menu

The Edit menu contains seven commands or links to features.

See also:        Cut, Copy & Paste

Add & Delete Lines

Cost Center & Statistics Setup

Move/Change/Combine Cost Centers

4.2.1 Cut, Copy & Paste

On the Edit menu, select Cut, Copy, or Paste commands. These are the standard
Windows commands that allow you to Cut, Copy, and Paste data.  You can use
these functions to move data from Excel, or any other Windows application, to a
cost report file, or from a cost report file to any Windows application. You can also
use the standard Windows keyboard shortcuts for each function: CTRL+C (Copy),
CTRL+X (Cut), and CTRL+V (Paste) to achieve the same results.

If you use your mouse pointer to highlight and select a cell or multiple cells, you
can right click the highlighted area and chose one of the three commands from the
context menu that will appear.
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Note: The Cut, Copy, and Paste commands will only work if the Display Column/
Row Headers options are checked on the Form Options dialog box.

4.2.2 Add/Delete Lines

The Add Lines and Delete Lines buttons are only enabled when you have a
worksheet open that allows lines to be added and deleted (for example,
Worksheet A-8 in the Hospital cost report).  In the example below we are adding
lines to A-8. Enter the range of lines you wish to add in the From and To boxes
and click the Add Range button. To add one line, enter the line number you want
to add in the Line box and click Add Single.
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The worksheet specific tab will show you the lines that can be added.

The Delete Lines button works the same way as Add Lines, except you delete a
single line or a range of lines.

4.2.3 Cost Center & Statistics Set Up

This feature is used to set up cost center structures and statistics.  You can add
and delete cost center lines by entering the line number in the Line Number box.
Once the cost center structure has been established for the overhead cost
centers, enter the stat code and label in the open cells to the right of each cost
center.
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The following example illustrates adding subscripted line 9.01.  The buttons at the
bottom of the dialog box give you the option of Add, Delete and Apply.  The Apply
button will apply the cost center code indicated on the Apply button.  You can
scroll through the list of available cost center codes and select a different code. 
The system automatically retrieves the appropriate cost center code for the line
number entered in the Line Number box.

You can also click on the Stat Codes tab, to the right of the Cost Center tab, and
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select which Stat Code to apply to the line you are about to add. The below image
is from the 2552-10 cost report, Stat Codes are system specific, so may look
different and have different options available if viewing a different system. 

If you highlight a cost center in the top section of the dialog box and then activate
the Stat Codes tab, you can easily change the Stat Code and Stat Label.   The
screen shot above shows the Stat Code drop down list with 09 PATIENT DAYS
selected. To apply that Stat Code you would select it from the list and click Apply.

HFS has incorporated certain automatic statistical codes and also the ability to
duplicate statistics from one B-1 column to another.  Allowable statistical codes
are 01 through 99. If you enter a stat code unique to a specific cost center, then
that corresponding column on B-1 will be open for input.

When the same statistics are used for more than one cost center, entering
duplicate stat codes will copy stats from one B-1 column to another. A good
example of this would be the capital-related cost centers (1.00, 2.00, 3.00, and
4.00), as these generally use square feet as a statistic. If you enter 01 as a stat
code for all four capital-related cost centers (i.e. 1.00, 2.00, 3.00, and 4.00), the
only capital-related column that will be open for input on B-1 will be column 1.00.
Once the stats have been added in column 1.00, these stats will be duplicated in
columns 2.00, 3.00, and 4.00 after calculation. 

In addition, if you would like to enter salaries, charges, or accumulated costs as
statistics, the following automatic stat codes have been set up:

S = Gross Salaries
C = Gross Charges
I = Inpatient Charges
O = Outpatient Charges
P =  Total Patient Days
T = Total Patient Days including Swing-bed days
# or negative number = Accumulated Cost

Note:  The # is no longer used in the .mcrx form sets.  The automatic stat codes I,
O and P are used in the 2552-10, 2540-10, 265-11, 1728-20, 1984-14, 2088-17,
216-94 systems.
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In the example above, line 9.01 was added with a cost center code of 00901 and a
Stat Code of 09.  Note that the Cost Center Description for line 9.01 is a white cell.
 It can be edited.  To modify the Cost Center Description, double click on it, and
then edit it by typing in the new description or changing the existing one.

It is important to understand that you can add and delete and edit the information in
this dialog box but none of the changes are saved to the cost report unless you
click OK.  If you click Cancel, all of your changes are abandoned and the cost
centers remain unmodified.
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4.2.4 Move/Change/Combine Cost Centers

The Move/Change/Combine feature is a convenient way to add data from one cost
center to another, or replace data from one cost center over another.

 

All the cost center lines will appear in the dialog box.  There are several ways to
perform an Add or an Overlay action. Using the Add feature will take the data from
the line indicated in the From box and add the data to the cost center line indicated
in the To box.  In this example all the expense data from cost center line 6.00, will
be added to cost center line 7.00.

 

Using the Overlay feature will take the data in the From box and Overlay (Replace)
the data in line entered in the To box.
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In this example, if you click the Overlay button, all the expense data present in
cost center line 52.01 will replace the expense data currently present in cost center
line 52.00.

Note:  Whenever this feature is used, the From cost center line is deleted if it is a
subscripted line (i.e. line 1.01). This is true for both the Add and the Overlay
commands.  Using the second Overlay example, note that line 9.01 is setup to
Overlay the data in line 9.00. Click the Apply button to perform the Overlay.

Note:  Once an Add or an Overlay has been performed, there is no way to undo
the results.  Be sure that your Move/Change/Combine is correct before applying.

After the Overlay, line 9.01 (the From line) was deleted and the data that was in
line 9.01 is now in line 9.00.  You can also use the Arrow buttons to Overlay or
Add data from one cost center line to another:
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In the example above, if you click on the down arrow,  the line with the green arrow
(triangle) will be the From cost center line and the one immediately below will be
the To cost center line.  Likewise, If you click the Up Arrow, the To cost center
would be the one immediately above.  You can then toggle between the active
Add/Overlay icon to the right of the arrows. You can use the arrows to change the
From and To lines to meet your requirements.

4.3 The Forms Menu

From the Forms menu you can open, delete, print, and print preview active
worksheets.

Select the Open command and the following dialog box will appear.  Select or
clear the various check boxes to choose which forms you want to open.
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Note: When choosing to open a worksheet that has a component or title
associated with it, you must specify one or more components/titles to open.

Note: When a worksheet is open, press F1 to display the CMS instructions for the
active worksheet.

At the bottom of the worksheet list, HFS has a number of additional informational
worksheets.  These include- a HCRIS Summary Report, Import Error Report
(IER), 700 Report (ECR Comparison Report), 800 Report (MCRX Comparison
Report), Threshold and a number of Special Reports.
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The Delete Form option works exactly the same as if you were opening a form. 
For every form you select to be deleted, a warning box will appear after you click
the Delete button, asking you whether you are sure that you want to delete the
chosen worksheet. This is because once a form is deleted, the data is lost and
cannot be recovered.
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If you have a worksheet open, the Print and Print Preview commands will
automatically print or print preview the active worksheet.

See also:        Form Options

 

4.4 The Options Menu

23BUThere is a Preferences command under the Options menu.

Select Preferences to open the Preferences dialog box. Notice the tree-view on
the left side of the dialog box. Click on any item in the list to expand or contract an
item.
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4.4.1 Form Options

Select Form Options to see the various options applicable to worksheets, or
forms.  The Form Options screen is the default screen and will always appear
whenever Preferences are selected from the Options menu.

You should always select the first two options: Display column headers and
Display row headers.  When these options are selected you will see row and
column headings on the outside edges of all your onscreen worksheets.
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In this screen shot you can see line or row numbers on the left outside edge of the
worksheet. For columns there are letters at the top outside edge of the worksheet.
Both areas are circled in red.  Selecting these two options give the worksheets the
same appearance as a standard spreadsheet.  These options must be selected to
enable the Cut, Copy and Paste functions.

Other options on this screen include:

Columns are resizable

Rows are resizable

Mark notes on cells

Show cell hints

Show progress bar

You may customize the appearance of worksheets using Cell Color Options. You
can also choose from a range of possible behaviors for the ENTER key and the
ARROW keys in the Key Action options.

Form Print Options

Click Print Options to open the Form Print Options screen.

This screen is a sub-menu of the Form Options screen.  All of these options apply
specifically to worksheets or forms. You can choose to print different text elements
on printed worksheets.  Select which items to include in your printed worksheets:
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File name on reports

Page numbers

Date and time on reports.

There are two additional options that restrict the types of reports that will be
printed.  Select either option if you want to print: Only Title XVIII, or Only Title
XIX reports.

The last option on this screen will Print Excluded Lines in the Management
Reports feature. You can select all, or none, or any combination of these options.

Print Color Schemes

Click Print Color Scheme to open the Print Color Scheme Options screen.

This screen allows you to select the color scheme you would like applied to your
print jobs. 

700 Reports Options

Select 700 Reports and then select the cost report type to configure available
options.
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For each cost report type, you can choose to: Display zero differences and/or
Only Display Settlement Data.

800 Reports Options

Select 800 Reports and then select the cost report type to configure available
options.



59The Main Menu

© 2025 Health Financial Systems Version 5.0.7

For each cost report type, you can choose to: Display zero differences and/or
Only Display Settlement Data.

4.4.2 Setup Options

Select Setup Options to configure the various software system options.
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Files

Click File Locations to specify one or more default file locations for various types
of cost report system files. To change a file location, select it from the list of
locations and click the Edit Item button.  Enter the file location, or click the Open
File button to browse and select a location.

Select Recent Files to enter the number of recently opened files to display on the
File menu under Recent Files.

Enter the number of recently used files you want to be displayed when you select 
Recent Files from the File menu.  You will see a list of the most recently used
files.  To clear the list and start building a new list as you open more files, click the 
Clear List button.

Environment

Select Environment to configure Environment options.
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You can choose to:

Show the Task Pane

Show tabs for open forms

Show file tips in Explorer.

 

Netsync

This screen is also where you configure Netsync options. (See chapter 2 for a
complete explanation of these options.)

Headlines

Select Headlines to customize the visible Headlines in the Task Pane.
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Scroll through the list of available RSS feeds and click to select or deselect items
in the list.  Click to enable the option to filter out articles by date, and then enter
the number of days before articles are no longer shown.  Select the option to limit
the maximum number of displayed articles and then enter the maximum number of
articles to allow.

Toolbar

Select Toolbar to customize the toolbar at the top of the User Interface.
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The first of the two lists contains all Available Commands that may potentially be
used on the Toolbar. The second list contains only Displayed Commands. 
Displayed Commands are the commands that are currently assigned to and
appear on the Toolbar.  To add items to the Toolbar, select an item in the list of 

Available Commands.  Then click the Right Arrow button  to move the
selected command from the Available Commands to the Displayed Commands.
 To remove items from the Toolbar, select an item from the list of Displayed

Commands and click the Left Arrow button  to remove the selected item
from the Toolbar and move it onto the list of Available Commands.

 

Versions

Select Versions to customize the way files are converted or not converted.
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Select any or all of the three options available.  The first option causes the
software to open cost report files created with newer versions of the software. 
The second options enables an onscreen warning before the software converts a
cost report file from an older version to a newer version.  The third option disables
automatic cost report file conversions.

Backup

The of the Setup screens controls how backups will be performed.  Select
Backup to see the three Backup options.
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You can choose one of the three options that determine when backups are
performed.  The first option is Automatically Backup (upon close of file).  The
second option is Prompt before backup (upon close of file). This option also
backs up whenever you close your files, but will prompt you first so you can
confirm that you want to perform the backup.  The third and final option is the 
Manual backup option.

Note: To perform a backup manually you must select the third option and click OK
to close the Preferences screen. Then, on the File menu, select Backup.  Enter
the destination folder where you want the backup files to be copied.  Next, select
the types of associated files you want to include in the backup. Click OK and the
backup will be performed and copies of your cost report file and related files (if
you selected related files to be backed up) will be in the backup folder you
specified.
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4.4.3 Import and Export Options

Click to open Import and select Batch to setup preferences for Batch Imports of
ECR files.

Follow these steps to Import Batch ECR files.

1.  Select the File Types you want to import.  Then select files or file locations as
described in 2 or 3, below.  You cannot select both.  The next two options are
mutually exclusive.

2.  Specify the folders that ECR files will be imported from.

    a.  Add to the list of folders by clicking the Add button.

    b.  Remove folders from the list by selecting a folder and clicking the Remove
button.

3.  Identify ECR files to import.

4.  Select the output folder for the cost report files created during the Batch
Import.  Click ECR Files to set additional options for ECR Import.  You can
select cost report subsystems and set options for each type of cost report file.
These options include printing various reports and the destination for the
reports.
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Batch Export

The Export options apply to HCRIS files only and therefore this is a section that
does not apply to cost report preparers.
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4.4.4 Auditor Options

Select Auditor and then Options to see the list of cost report systems for setting
Auditor options.  Select a cost report system from the list.

In this screen shot the 2552-10 system is selected from the list.  The Auditor
preferences screen for 2552-10 becomes visible. These options control  how the
new .Auditor file is created when a cost report file is used with the Medicare
Auditor feature for the first time.  There are two options.  Create the new, blank or
empty .Auditor file.  There will not be any adjustment in the .Auditor file unless you
select the Create default adjustment check box. Select that option and the new
.Auditor file will be created and populated with three default main audit
adjustments.  Alternatively, you can have three default adjustments populate your
new .Auditor file.

In the screen shot shown above, the new Auditor file was created with the option
to create the default adjustments selected.  The items enclosed in the red box are
the three default adjustments that are automatically created when this option is
selected.  These options are more commonly used by Medicare auditors, but they
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are also used by cost report preparers.

The other option is to use a template file when the new .Auditor file is created. 
The template file may contain many or no main and detail adjustments.  Whatever
is present in the template file will be used to populate your new file.

See also:        Auditor Options & Utilities

 

4.4.5 System Options

The next series of screens are available under System. Select System and you will
see two items: Information and Verify Version. Click Information to view the
System Information screen.

This screen is used for diagnostic purposes by HFS support staff.  The yellow
highlighted areas contain important information about your computer and the
software installed on it.

Another diagnostic tool is accessed by choosing Verify Version.
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This is the introductory screen that describes the Verify Version utility.  Click the 
Start button to run Verify Version.

Verify Version will check all HFS cost report software subsystems for errors and
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indicate, in the status column, the condition of the software subsystem.  In this
example, there were errors detected in the Hospital 2552-10 program.  To see
details about the error detected, click on error.  To have the system repair itself,
click the Fix Version button at the bottom. 

 

4.4.6 PS&R Options

Select PS&R Options to configure preferences for the PS&R feature.

There are two options available.  Statistics Option and Difference Report Option
both give printing preferences. 

Click Assignments to see the PS&R Assignments options.
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There are two categories of options regarding the behavior of worksheet
assignments.  The first option controls what happens when PS&R data is assigned
to a worksheet and there is already an existing PS&R assignment for the same
worksheet, line, column etc.  You can replace the existing detail:

Only if the detail is blank

Always

Never.

The next series of options relates to what happens when line numbers and statistic
codes are assigned to PS&R report data.  Your choices are to replace the existing
detail data:

Only if existing detail is blank

Always

Only if existing detail is a stat code

Only if existing detail is a line no.

Never.

We strongly recommend you to select Always - Always here. 

The last set of options for the PS&R controls the behavior of Audit adjustments
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exported to the PS&R as worksheet assignments.  These options are for use by
Medicare Auditors and are not used by cost report preparers.

 

4.5 The Tools Menu

There are many powerful features on the Tools menu.

Most of the features that are started from the links on the Tools menu are
discussed in other parts of this manual or in other publications. This section will
discuss those features and utilities that are not discussed elsewhere. (See items
highlighted in screen shot, above.) Specifically, this section briefly discusses these
items:

 CMS 339 Questionnaire;

Lookup Contractor Number;

 CBSA Lookup Tool;

4.5.1 CMS 339 Questionnaire

Note: The CMS 339 Questionnaire has been implemented into the cost report
forms.  We do have the ability for users to use the Tools - 339 to complete
Physician Time Allocation Exhibits and Medicare Bad Debt Listings.

The CMS 339 must be submitted with each Medicare cost report (with the
exception of the 287-22). On the Tools menu select CMS 339 Questionnaire to
open the CMS 339 Questionnaire. When you open the 339 for the first time for any
cost report the software creates a  separate file with the same name as your cost
report data file, but it has a file name extension of .xprq.  For many systems the
339 questionnaire is now incorporated into the cost report (for example Worksheet
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S-2, Part II for the 2552-10). You can complete all exhibits using the software.
When you open the 339 for the first time you will see this dialog box.

To enter data in the 339 you must first setup Departments, Physicians and
Specialties.

In each of the three tabs, you can also select Edit or Delete.  Using these options,
you can Edit or Delete Departments, Physicians and Specialties.  When
finished, click Close to return to the 339 Exhibits.

When finished you must print the 339 exhibits.  The 339 exhibits are not part of the
ECR file and therefore, they must be printed and submitted with the rest of your
cost report.

 

4.5.1.1 Add Physicians

In this example, the Physicians tab is selected.  The Emergency Department is
populating the Physician's Department box. To populate the box with a
Department, you select a Department form the Departments list on the left.  When
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you select a Department it will be highlighted.  Click the right arrow to move the
selected Department into the Physician's Department box.  You can move
multiple Departments into the list.  You can move Departments back and forth
between the boxes by clicking the left and right arrows.  If you select multiple
departments at the same time, you can move them all using the move multiple left
and right arrows, located beneath the regular arrows.

After you select the Department, you need to enter the physician name in the New
Physician list box. In a new 339 file the list will be empty.  As you add physicians
their names will populate the list and can be chosen from the list.

Before you can actually add the physician you must also select his or her specialty.
 Select a specialty from the Specialty list.  When you have data in the New
Physician field, the Specialty field and the Physician's Department field, the Add
button will be enabled.

Click Add to add the physician.  Repeat the process as needed to add more
physicians.
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4.5.1.2 Add Specialty

Select the Specialties tab to add a Specialty.  The Add Specialty dialog box
appears.

Select a Specialty from the list of Specialties. If you don't find the Specialty you
want, you can enter the name of the Specialty in the New Specialty box.  Click
Add to add the selected Specialty or the New Specialty.
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4.5.1.3 Add Department

Click on the Departments tab to see the Add Department dialog box.

In this example the Emergency Department was selected and the Provider was
already filled in.  When the Department was selected, the Add button was
enabled.  Click Add to add the Department.

 

4.5.2 Lookup Contractor Number

The Lookup Contractor Number tool will find the Contractor Number that is
associated with the particular facility.  To use this tool, enter in a provider or Home
Office number andclick the Lookup button.  The Contractor Number will be
returned. 
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4.5.3 CBSA Lookup Tool

The CBSA Lookup tool will find any CBSA number in the United States.  To find a
particular CBSA code you need to select the name of the county and prior CBSAs. 

Some CBSA codes are two digit numbers.  In the cost report you must input a five
digit CBSA code.  When you enter your CBSA code in the cost report and a two
digit code  was returned by the Lookup Tool, precede the two digits with three
nines (999).  For example, if the displayed CBSA code is "01", you would enter
"99901" for your CBSA code in your cost report.
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4.6 The View Menu

There are certain options under View to customize the screen and to view certain
reports/files.

Clicking on the Tool Bar or the Task Pane will simply close or reopen these
features.  As long as you have calculated a report, clicking on Edits will show the
Edit report from the last calculate.

The CMS Print Image and ECR Import Report will only be available if the open
cost report was created by importing an EC file.  As long as the ECR file and the
PI file are saved in the same folder, when you click the CMS Print Image
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command, the Print Image version of the current worksheet will open. If they are
not saved in the same folder, you will be given the option to browse and locate the
PI file.

Once the PI File worksheet is open, click on Forms > Print Form and the dialog
box shown above will appear.  You can print the entire PI File or the active PI
worksheet. Select the ECR Import Report command to display a report with
information pertaining to the ECR import process.

 

The Adjusted Report view will only be available if you are using the Medicare
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Auditor feature. To learn more about this feature, please refer to the Medicare
Auditor section in this manual.
 

4.6.1 PI Viewer and Print

You can view the print image of a worksheet from any open worksheet in the cost
report if the PI and the ECR files are in the same folder as the cost report file.  
From within an open worksheet, click on View and select CMS Print Image.  The
PI version of the active worksheet will be displayed (see below).

To print a PI file or a single worksheet from within a PI file, while viewing the PI file
using the PI viewer, click the Print Form button on the toolbar.

A special dialog box will appear on the PI Viewer screen.
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You may print either the current open worksheet or the entire PI file.  Select either
option by clicking on one of the two radio buttons in the dialog box and then click 
Print.

 

4.7 The Window Menu

The Window menu allows you to configure the User Interface screen in the cost
report software.  Click Window to open the Window menu.

If you have more than one form open, you can display multiple forms
simultaneously. Depending on which display option you choose, you can display
open worksheets horizontally, vertically, or in cascade style. Here is an example of
two worksheets displayed horizontally.
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In addition, you can minimize all open worksheets by clicking Minimize All or close
only the active worksheet by clicking Close Active Window.  If you have multiple
windows displayed simultaneously, the "active" window is the window within which
your cursor is active.

If you have multiple worksheets open, you can switch back and forth between them
by selecting the worksheet from the list of open worksheets on the bottom of this
menu.

Note: The fastest and easiest way to toggle between multiple open worksheets is
to click on the worksheet name tab located at the upper left corner of any open
worksheet.  When multiple worksheets are open, their respective tabs are aligned
next to each other at the top edge of the worksheet window.

The worksheet tabs in this screen shot are highlighted in yellow.  Click on any of
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these tabs to immediately switch to that worksheet.

 

4.8 The Help Menu

Click on Help and the menu shown below will appear. Click on Contents and the
complete user manual will appear on your screen.

Select CMS Instructions to display the complete CMS cost report instructions. 
Select the topic you want to read, and the CMS instructions will be displayed for
that topic.  As previously mentioned, if you have a worksheet open, press F1 to
display the CMS instructions for the open worksheet. Text shown in RED denotes
a change/update from the last CMS instructions. Text shown in Blue is an HFS note
that was added to help clarify CMS instructions. 

Clicking the Search tab to use the Search feature, where you to enter a keyword
to find all occurrences of the word wherever it appears throughout the CMS
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instructions. In the below example 'DSH' was searched and 9 worksheets with
'DSH' were found. Every mention of 'DSH' is also highlighted.

If the Network Synchronization feature is being utilized, you can “synchronize” to
the network version at any time by clicking Synchronize with Network.  There is
also an option to Check for Updates under the Help menu — this is the same
process as previously mentioned when we discussed the Task Pane.

Email File is used to send cost reports files to the HFS support@hfssoft.com
email.  This feature will only work when you do not have a cost report file open. 
This feature may not work for all clients depending on what type of email is being
used/installed on their computer. 

The About option displays a dialog box with software version data and Recent File
Info.

mailto:support@hfssoft.com
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5 Enter Data

This section explains how to enter data in your cost report.

See also:

 Open Worksheet

 Data Entry

 Calculate

 Print the Report

 

5.1 Begin New Cost Report

There are two ways to begin your new cost report- File | New Report Wizard and File | New.  Both
ways allow for a cost report to be created using the prior year report as a template to bring over
data that does not typically change from year to year.  Using a prior year report, is not required.  A
new cost report can be started from scratch. 

5.1.1 New Report Wizard

The New Report Wizard is used to help get your current year cost report started
by using a prior year cost report. The idea is to transfer prior year data that does
not typically change year to year to the new cost report you are creating.  

Currently, the only systems available for the New Report wizard are 2552-10,
2540-10, 1728-94, 1728-20, 287-22, 287-05, CHDRX and LTCIRX. 

After clicking on File | New Report Wizard you will see a pop-up screen with
different options on where your prior year report can be found or not having a prior
year report. 
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The current options are-
SaFE 

This option is for users who have previously submitted their cost report
to our SaFE website.  If you select this option, you will be prompted to
log in with your HFS credentials.  Once logged in all cost reports tied to
your user account in SaFE will be shown.  You can select a report from
this list and click the Next button. This next screen allows for the new
fiscal year to be entered and also provides a list of check boxes asking
which information you would like to have brought into the new cost
report from the prior year cost report, select Next to go to the next
screen.  This final screen asks where you want this cost report file to
be saved at and what do you want the file to be named. click Finished
when done.  

Local Computer or Network
If your prior year cost report or EC file is located on your computer or
facility's shared network drive you would select this option and click
Next. The Select local file screen allows you to browse and select the
prior year file.  Once you have the file in the Template Report text box,
click the Next button. This next screen allows for the new fiscal year to
be entered and also provides a list of check boxes asking which
information you would like to have brought into the new cost report from
the prior year cost report, select Next to go to the next screen.  This
final screen asks where you want this cost report file to be saved at
and what do you want the file to be named. click Finished when done.  

I don't have a previous report 
No prior year report, that is OK select this option to walk through
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setting up a new cost report and select the Next button.  This screen
presents a drop down box where you can select the type of cost report
you want to create, then click Next.  On the Cost Report Information
screen you will input the Fiscal year and basic data about the facility. 
Once you have filled in at least the required data (notated by *) click the
Next button. This final screen asks where you want this cost report file
to be saved at and what do you want the file to be named. click
Finished when done.   

There is another option but is not currently available-
HCRIS

This option will allow HCRIS users to access the HFS HCRIS online
Database to pull and use files from as templates to start their new cost
report file. 

5.1.2 New File

Click New to open the New File dialog box.  This is where you enter the details to
create a new cost report file. The process is exactly the same as previously
described when creating a new file from the Task Pane.

1.     In the File Type list box, select the type of cost report file you want to
create.

2.     In the File Name text box, enter a file name for the new cost report.  Do not
accept the default name, which is "New", or "New01", etc...  Give your file a
meaningful name that will enable you to identify the  contents of the file.

3.     Click the Use Template check box is you want to use a template file to
populate your cost report with data as it is created.

4.     If you selected the Use Template option, click the Open Folder or Browse
button and find the file you want to use as the template and select it.

5.     When finished entering information in the dialog box, click OK to create and
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open your new cost report file.

When the file creation process is finished, your screen will sort of go "blank." 
However, if you look closely, you will notice significant changes occurred in the
main User Interface window after you created the new file.  There will be screen
elements that display information about your new cost report file.

The file name will appear in the lower right edge of the window.

The cost report period beginning and ending dates are visible (if present in the
template file) in the upper right portion of the screen.

The provider name is visible beneath the menu bar (if present in the template
file).

The provider number is visible beneath the menu bar (if present in the template
file), and

Some of the Toolbar buttons will be enabled because your cost report is open.
 

Before any files are opened, the toolbar has limited functionality.  It looks like the
example below.

When a cost report file is open, the tool bar changes and looks like this:

If you open worksheets the other buttons on the toolbar will be enabled.  The Add
Lines and Delete Lines buttons are enabled only when you open a worksheet that
you can modify by adding and deleting lines.

See also:        Opening a New Cost Report
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5.2 Opening a Worksheet

Open a worksheet to enter data in your cost report.  Click the Open Form button,
or from the Forms menu, select Open Form.

 

Either method will open the Open Forms dialog box.

 

Click the check box to the left of any worksheet or combination of worksheets and
then click Open to open the selected worksheet(s).  You  can also double click a
worksheet to open it.  For worksheets with multiple parts or iterations, you will see
an additional list of worksheets in the Components box.  You must select one or
more Components to open these worksheets.
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Another method of opening worksheets is to use the Find box.  Enter the CMS
worksheet name in the Find box to locate a worksheet in the  list of worksheets.  If
a matching worksheet is found it will be highlighted in the list of worksheets, but
you must still select it by checking the appropriate check box or double clicking on
the highlighted description.

Also, in the upper left corner of the User Interface, directly under the menu items,
there is a drop-down text box.

Entering a worksheet name in this box and press ENTER to open that worksheet. 
As you work on your cost report, the names of worksheets you have opened will
be stored in the drop down list. The list box will automatically display the name of
the worksheet in which the cursor is active.  If no worksheets are open the list box
displays the name of the last opened worksheet. To re-open a worksheet select it
from the list of previously opened worksheets.

 

5.3 Data Entry

The screen depicted below is a blank worksheet S-2, Part I in the CMS 2552-10
form set.  Once a worksheet is open, you can enter data in any open “white” cell.
Colored cells are not open for input, but will usually be filled in after the cost report
is calculated.
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You may calculate the cost report as often or as seldom as you want. There is no
limit on the number of times you may calculate a cost report.

Note: Many worksheets have tabs for worksheet parts or sections. (See tabs for
worksheet S-2 above, Lines 1-19, Lines 20-104 and Lines 105-171)

In addition, most worksheets have a scroll bar to the right of the active worksheet.
Scroll up or down to show more of the worksheet.

Dates are entered in the following format and do not require the “/” to be entered:
mmddyyyy.  There is a drop-down box that will display a calendar that you can use
to enter a date.

Some forms will open with default data populating one or more cells. In the
example displayed above, columns 4, 5 and 6 are populated with "N" by default. 
You can edit the default values by typing over them or deleting them.

Note: You can choose which cell the cursor will move to when you press the
ENTER key in the Key Action section of the Form Options part of Preferences.

To delete text in any cell, double-click on the cell to select the text and press the
DELETE key on your keyboard. You can also delete an entry in any cell by being in
that cell and using the Cut command (CTRL + X, or Cut on the Edit menu).
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5.4 Calculating

BTo calculate the cost report, click Calculate on the Tools menu, or click the
Calculate button.

The Calculate dialog box will appear and will display the Edit List which lists all
edits found in your cost report. It shows all the Level I, Level II and Serious edits,
plus Warnings and other informational edits. You can print the edits displayed in
this dialog box by clicking the Print button located in the lower left corner of the
dialog box.

Note: The Edit Report will also display all the HCRIS edits.  These edits are
important to the MACs when they process the report. The Consistency and
Relational edits are equivalent to Level I and Level II edits.

There are several helpful features in the Edit List.  Click on a particular edit to see
a detailed description of the edit displayed in the Detail section at the bottom of
the dialog box. 
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You can suppress some categories of edits.  Right click on the heading for a
category of edits and then select Exclude “Serious Edits” from Edit Report. 
You can exclude Serious Edits, Warning Edits, Informational Edits, HCRIS Serious
Edits, HCRIS Warning Edits and HCRIS Informational Edits. When a category of
edits is excluded, the heading for that type of edits is highlighted in yellow.
Whenever a category of edits are excluded, that option will remain in effect for all
cost reports of the same type.  For example, if you exclude a Serious Edits for a
Hospital cost report, Serious Edits will remain excluded for all Hospital cost reports
you work on  unless the option to exclude the edits is disabled.  Serious Edits will
not be excluded for other types of cost reports.

You can enter notes in the Notes tab in the Details section of the Calculation
Edits dialog box for any edit. This enables you to leave notes about why an edit
may not relate to the report or to aid other users on how to resolve the edit.  Notes
will be displayed as right aligned text in your edit listing.
 

5.5 Printing the Report

The Print feature gives you many options to print exactly what you want.  The
dialog box shown below contains various options.  You can preview any print job,
show only forms that contain data, and print to file.
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To print individual worksheets, click on the check boxes to the left of the
worksheets you wish to print, and then click Print. To print all worksheets, check
the All Forms check box and click Print.

For worksheets that have different titles or components associated with them, you
can select which component and/or title you wish to print. A good example of this
would be E, Part B, Title XVIII in the 2552-10 software.  You can limit the forms
that will be printed by selecting the option to print only forms from either Title XVIII
or Title XIX.  To print to file, click the Print to File check box. A dialog box will
appear that will allow you to select a location to save the file. You can choose to
save as a PDF file or a text file.
 

6 Submit Finished Cost Report

With the exception of the Home Office cost statement (287-22), all Medicare cost
reports must be submitted electronically. These include: Hospital (2552-10); Skilled
Nursing Facility (2540-10); Home Health Agency (1728-20); Hospice (1984-14);
Community Mental Health Clinic (2088-92); Rural Health Clinic  (222-17); End
Stage Renal Disease (265-11), Federally Qualified Health Center (224-14) and
Organ Procurement Organization (216-94).

To file electronically, the user must export the cost report data to special types of
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files that are required by CMS.  These files are collectively referred to as ECR
files.   In fact, CMS requires providers to submit two different computer generated
files:  an EC file and a PI file.  The EC file is the electronic cost report file and the
PI file is known as the print image file. The HFS software creates both files
simultaneously and writes them to the same destination.  The files are stored on
either a hard disk drive, a compact disk (CD), or a Flash drive and then mailed to
the MAC.  During the ECR creation process you will have the option of storing your
ECR files on the HFS SaFE website.  You should always choose this option.  See
the section that follows regarding the HFS SaFE website.

Once submitted by the provider, the files are processed by the MAC. The ECR file
is not automatically transmitted to the MAC by the HFS software.  You must mail
the CD or Flash drive containing the ECR files to the MAC.  You should consult
with your MAC regarding its submission requirements. CMS has created a secured
web portal, MCReF that providers may use to submit ECR files. You are also
required to submit a signed signature/settlement page, a signed and completed
339 Questionnaire.  The questions contained within the 339 have been
incorporated into the S Worksheet series for the 2552-10, 2540-10, 265-11, 1728-
20, 222-17, 224-14,216-94, and 287-22.  As a result, providers filing on those cost
reporting forms will not need to submit a separately completed 339. These
requirements may differ and you should not rely on this document.  It is your
responsibility to review your MAC's submission requirements and to comply with
those requirements.

Before an ECR file can be created, certain steps have to be completed:
• The cost report must be calculated.
• There must be no Level I errors.

•
If sending the ECR file on a CD, a CD must be inserted into the writable CD
drive.

•
If sending the ECR file on a Flash drive, a Flash drive must be inserted into an
available USB port.

• No MAC information may be entered in the MAC screen or under “Options”.
• A printer must be set up and ready to print if choosing the Wet Signature option.

Note: The ECR files will be created and returned via SaFE if using the Submit to
CFO signature option.

6.1 ECR Filenames

You do not choose the name of your ECR files.  The cost report software will
generate a name for the EC file and the PI file according to CMS regulations.  You
should understand the nomenclature, or rules that determine the file names of ECR
files.  Understanding this aspect of the process will enable you to verify the
appropriate files were created and are on the diskette or CD submitted to the

https://safe.hfssoft.com/
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MAC.

The EC file name is eight characters long and formatted as "LLNNNNNN",  where
"LL" are two alphabetic characters (which vary by provider type), and "NNNNNN" is
the six digit provider number. 

Provider Type First 2 Characters

Hospital (2552-10) EC

SNF (2540-10) SN

Home Health Agency (1728-20) HH

CMHC (2088-17) CM

Rural Health Clinic (222-17) RH

ESRD (265-11) RD

Hospice (1984-14) HS

FQHC (224-14) FQ

OPO (265-94) OP

Low/No Reports HL/EL

Home Office (287-22) not applicable - no EC file

For 2552-10, 2540-10, 1728-94, 224-14, 216-94, 265-11, 222-17, 1984-14, and
2088-17 systems the file name extension (the characters that follow the dot or
period at the end of the 8 character file name) is 4 characters, in the format
"YYLC", where:

"YY" is the last two digits of the year in which the cost reporting period ends;

"L" is a letter A-Z to distinguish between multiple reports filed in the same year;

"C" is the number of times the cost report has been submitted.

The ECR file for a hospital provider with a provider number of 123456 and a cost
report period ending 12/31/2015 would be named EC123456.15A1.

For the 222-92 and 2088-92 systems the file name extension will be three digits in
the format "YYL", where: the first two characters are the last two digits of the year
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in which the cost report period ended, followed by a letter, A or B, indicating
whether the EC file is a first or second submission.  For example, a first
submission RH file by a rural health clinic with provider number 123456 and a fiscal
year ending on October 31, 2015 will have the following file name: 
RH123456.15A.  If the RHC submits another cost report for the same cost
reporting period (e.g. 2015) the letter designation part of the file extension changes
from "A" to “B”.   This might happen due to a change in ownership or change in the
provider’s fiscal year. The RH file name used in the previous example would be
“RH123456.05B” if it was the provider’s second submission of the RH file for the
same cost reporting period.

The HFS software will also create a print image file when it creates the ECR file. 
The print image file is literally a “printable” version of the as-submitted cost report.
 The print image file follows the same naming convention as the ECR file, except
the file name always starts with “PI.”  For example, the print image file for the cost
report referred to in the previous example would be: PI123456.15A.  For the .mcrx
systems the print image file will be created as a PDF file and will contain an
additional file extension of “.PDF”.  For example, the print image file for the cost
report referred to in the previous example would be: PI123456.15A1.PDF.

The HFS software will print an encrypted Settlement/Signature page at the same
time it creates the EC and PI files.  This document must be signed and submitted
to the MAC with the CD or flash drive containing the ECR file. Please note that the
Signature/Settlement page printed contemporaneously with the creation of the
ECR file is the document that must be signed and submitted with the ECR file. 
Copies printed before or after the ECR export will not match the encryption code
of the ECR file and may lead to the cost report being rejected by the MAC.

Users should be aware that the cost report program not only prints a Signature /
Settlement page, but also creates a PDF file (Adobe Portable Document File)
which is an exact duplicate of the printed form.  This PDF file can be used to re-
print the Signature/Settlement page without any changes to the encryption code or
any of the characters on the form itself.  The PDF file is stored in the current year
data directory. The PDF file is useful if the Settlement/Signature page is lost,
damaged or if the user simply needs another copy.  The PDF file name is
generated automatically.   A PDF file created by the cost report program during
ECR export follows the same naming convention as the EC file.  The Signature/
Settlement page file name differs from the EC file name because “.Encrypted
Settlement Signature Page.pdf” is appended to the file name.  The file name for
the signature page file for the hospital with provider no. 123456 would be
“EC123456.15A1.“.Encrypted Settlement Signature Page.pdf””.  

To summarize, all of the software systems that use the .mcrx file extension will
create and move two files to the location you specify as the export destination
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when you export your ECR files.  Using the example of the hospital provider, those
files will be:

EC123456.15A1

PI123456.15A1.pdf

These are the two files you would submit to the MAC.  If for some reason you ever
need to reprint a copy of the signature page with the encryption codes, we create
a PDF copy of the signature page and we save it in the folder where your cost
report file is saved.  Using the same example, these three files would be created in
the folder where your cost report is saved.

EC123456.15A1
EC123456.15A1.Encrypted Settlement Signature Page.pdf

PI123456.15A1.pdf 

The files highlighted in yellow are the two files that were created and saved on
your CD or USB drive and are submitted to the MAC.  The third file is a copy of
your signature page that you can reprint without modifying the encryption codes.

 

6.2 How to Create ECR Files

The cost report must be open and calculated and free of Level I errors.  Point to 
Export on the File menu and select Create ECR File.



100 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

The Export ECR dialog box will appear. You can select first or second ECR
submission. The default is First Submission. The destination for the ECR file may
be changed by entering a valid location in the ECR Location box or by clicking the
Open button and selecting a location. Valid destinations include a CD, Flash drive
or other valid data storage.

Click on the file folder icon next to the ECR Location text box and a window
appears where you may browse and select the destination drive and/or directory
for the ECR file.

Note:  The target drive/directory for the ECR file may also be modified in the
Preferences window, under Setup Options, select File Locations and then click
ECR Files. To change the target destination click on the Edit Item button and the
cursor will appear in the text box and you can type the preferred destination. 
Alternatively, you can click the Open button and browse to and select the
appropriate location. If the submission option and target destination are both
correct, click OK and the ECR export process will begin.  The following dialog box
will appear and depict the progress and status of the ECR export process.

The Store Files in HFS SaFE  option is recommended and is covered in the next
section in detail. 
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If the export process is successful, the Settlement /Signature Page will be sent to
the printer and you will see the following dialog box .

Click OK.  The cost report program will display the result of the ECR export
process.  The name of the cost report file, EC file, PI file, provider name, provider
number and fiscal year will be displayed.  Either click Print to produce another
copy of the Settlement Signature Page or click Done.
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The Signature Settlement Page must be submitted with the disk, CD, or Flash drive
containing the EC and PI files.  If submitting using a system other than the .mcrx,
the user must also submit a printed copy of the CMS 339 Questionnaire because it
is not part of the EC or PI files.  It is always a good idea to confirm that the ECR
files are on the CD or Flash drive before submitting the ECR file.  Using Windows
Explorer or My Computer, navigate to the disk where the files are supposed to be
and confirm they are there and that they were created at the same time on the
same date.  Every year numerous provider cost reports are rejected because the
preparer made a mistake and the ECR files are not on the disk submitted to the
MAC.

HFS makes an automatic backup of the ECR files, and the encrypted signature
page, in the folder where you opened the cost report.  If you click on Options/
Preferences/Setup/File Locations, the "current year files" location is where the
backup is made.  For a hospital you would see ECxxxxxx.09A, PIxxxxxx.09A (or
09A.PDF) and ECxxxxxx.09A.Encrypted Settlement Signature Page.pdf (the
signature page).  
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6.3 Electronic Signatures

CMS published Medicare Cost Report Electronic Signature regulations in the IPPS
Final Rule published in the Federal Register on August 14, 2017.   CMS
incorporated the changes to accommodate the electronic signing option in the
2552-10, 2540-10, 265-11, 216-94, 1984-14, 222-17, 224-14, 1728-94, 2088-17.
HFS has been approved for these changes. 

The HFS system incorporated these changes and provides you with a convenient
method for providing an electronic signature either from the cost report preparer or
another person.  The following is a description of the HFS electronic signature
process.

The first screen of the ECR Export process will now ask you to specify how the
cost report will be signed.

The first option, “The report will be signed with a “wet” signature”, will take you
through the ECR export process with no changes.  At the end of this process you
will be able to print the encrypted Worksheet S and sign it as usual.
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The second option, “I will electronically sign the report”, will guide you through
putting your electronic signature on the encrypted Worksheet S.  

The third option, “The CFO or Administrator of the provider(s) will sign the report.
(Requires SaFE)”, will walk you through the steps necessary to collect a signature
from the individual you identify in another step.

Option 2 
Choose the second option to sign the cost report yourself.

You will be presented with a screen where you can enter your first name, last
name, and title.  Then you must certify that you have read the certification
statement.
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While creating the ECR files through the ECR Export process you will be provided
with new options.  HFS recommends that all users choose the “Store Report in
SaFE” option for storage and to take advantage of the pre-acceptance checks the
SaFE site performs.  This option is mandatory if you intend to have the system
collect a signature from someone other than you.

The ECR Location will be the same if you do not electronically sign the report or
signs if you sign it yourself.
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If you opt in to use the HFS SaFE you will need to provider your username and
password.  This is the same information that you provide to get updates through
Check for Updates or when you log into the HFS website.  If you do not have a
username and password, please go to HFSSOFT.com and click Register/Join.

The ECR Submission box can be changed if this is not your as submitted report. 
This option is used if more than one report is filed within a calendar year. 
Amended reports are identified by going to Worksheet S, Part III and editing line 3.
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You must select "Agree and Continue" to proceed.  Then the system will process
all of the records necessary to make the EC and PI files and the encrypted
Worksheet S.  

The ECR Export process is complete and you can now submit your ECR files.
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If you opted to use the HFS SaFE site, you will be given the option to add files to
your SaFE submission. 

Click “Send to SaFE” and your files will be transmitted.

Say OK to the final SaFE Usage Statement and your submission will be complete
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with your electronic signature.

If this cost report will be signed by a CFO or Administrator and you are not that
person, select “The CFO or Administrator of the provider(s) will sign the report.
(Requires SaFE.)”
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The next screen is where you enter the first name, last name, title and e-mail
address of the person who will sign the report.  This screen also gives you the
option to not request a signature if the file does not pass all of the SaFE pre-
acceptance checks.  HFS recommends you select this option.
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The next screen will present you with an option to add files to the “signing
package”.  HFS will present the signor with a full PDF of the MCR and all
associated system files.  If you would like to add more files click the “Add Files to
Package” button.  Files with confidential or sensitive data should not be added
using this process.   HFS is not responsible for the consequences that may arise if
you upload confidential or sensitive data files.
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When you choose to have someone else sign the report no files will be created on
your computer because the files will not be finalized and ready for submission until
the cost report is signed. You will be notified when the files are signed and
processing is complete. You will receive a link to retrieve the files from the HFS
SaFE site. You must submit the files after you retrieve them from SaFE.
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SaFE will take care of the signature from this point forward.  You will see that the
process is well documented for both you and the signer.  

You must click  "Agree and Continue" to proceed.
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You will receive the standard SaFE e-mails.  First you will be notified that SaFE
received your submission.
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The next e-mail shows the pre-acceptance status.  Yours will most likely say
“Passed”, but if it does not please contact support@hfssoft.com or 888.216.6041
right away.  We are notified as well and will most likely already be looking at your
report.
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The person who was identified as the signer also received an e-mail.  If you
elected to only have the signer notified if the cost report passed the pre-
acceptance check, the e-mail was sent by SaFE after you received the notice that
the cost report passed the pre-acceptance check.  If this option wasn't selected
the e-mail was sent prior to this check.
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The preparer is notified that the signer was e-mailed.
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When the signer clicks the “Click here to sign or review the report” link, they are
taken to a screen where they must enter the e-mail that was specified by you.  An
HFS registration is not required and the only report they will have access to is the
one on that particular link.  Then they can click the “Continue to Electronic
Signing…” button.
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The signer is then taken to the next screen where they can view and download the
MCR files.  Then the signer must choose “I have read and agree…” or they can
choose to reject the report.  If the signer chooses to reject the report, you will be
notified through e-mail immediately.  If the signer chooses to agree they will then
be prompted to electronically sign the report.

The report has been signed.  The HFS SaFE site kept a log of the activity.
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The signer receives an additional e-mail finalizing the process.  
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A copy of the signed and encrypted Worksheet S is attached to the final email
received by the signer.

You also receive an e-mail indicating that the report was signed.  The files you
need to submit will be attached to the email.
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We have created three tutorial videos for:
Preparation of submission for CFO signature
CFO Signature
Self Signature

Here is a link to these tutorials: https://www.hfssoft.com/webinars/tutorials/ 

Please contact us with any questions, comments or concerns about this new
feature.  

https://www.hfssoft.com/webinars/tutorials/
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7 Store and File Electronically (SaFE)

Health Financial Systems built a website for storage of our user’s Medicare cost
report files and associated files. The SaFE site is currently available to all HFS
users. The site is currently free to use during this testing period. Any data
submitted to the site during the test period will continue to be stored regardless of
the user’s decision to purchase the service in the future.

Users of the 2552-10, 2540-10, 265-11, 216-94, 1984-14, 222-92, 222-17, 224-
14, 1728-94, 1728-20, 2088-92, and 2088-17, Health Financial Systems Medicare
cost report software will be offered the option to store their data on the HFS SaFE
website at the point of exporting their ECR file. SaFE does not, in anyway, reduce
or change the normal Medicare Cost Report filing requirements. You must still put
the EC and PI files on some sort of storage media and mail them to your MAC.
Your MAC will require a signed certification page, the EC and PI file.

SaFE is not intended and should NOT be used to store protected data. Medicare
Cost Report data purposely does not contain protected data. This data can be e-
mailed without using secure e-mail and will eventually be published in the CMS
public use files. Our SaFE server has the ability to upload work paper files and
other files that you select. Do NOT transmit PII or PHI to the HFS SaFE site.

Your data will be transmitted using SSL and will be stored on secured HFS
servers. Only users on your account will have access to the files that are
uploaded. Again, SaFE is intended for Medicare cost report data and associated
files. If HFS becomes aware of potential PII or PHI data being stored on the SaFE
server in your account, you will be notified and the data will be destroyed.
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7.1 SaFE - How it Works

You will notice the SaFE option on the Export ECR window.

If you are wondering, “Why should I do this?”. Click on the link to access the web
page about some of the SaFE advantages and features. If you would like to give
the SaFE product a test run, click the check box for “Store Files in HFS SaFE”.

Then click “Next” to continue with the ECR export process.  The next screen has
four items requiring input.
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1. Click the Checkbox to select the option to store your files in the HFS SaFE
again. You can change your mind from the answer you gave on the prior screen
or leave it the same. If you do not have the option check marked you can just
click the Next button to move onto the normal ECR process.

2. You will need to log In using your HFSSOFT.com credentials. This is the same
username and password that you use for Check for Updates or installing from
our Downloads page. If you do not know your username or password, then click
the 'Forgot Username or Password?' link.

3. The MAC Information is our best guess at which MAC will actually process your
report. REMEMBER: YOU STILL HAVE TO SEND YOUR REPORT IN ITS
ENTIRETY TO YOUR MAC JUST AS YOU DID LAST YEAR. If you disagree
with our best guess, you can go ahead and use the drop down box and pick the
correct MAC. We use this information to give you a link to the MAC’s website for
mailing instructions; we do not transmit the file to your MAC.

4. We just want to make it clear that you still have to file your cost report by
mailing it to the MAC. HFS is really trying to avoid any confusion. If you do not
mail your cost report as required by law, your MAC will consider it late and all
penalties and interest will start. 

After you click Next to continue with the process you will be asked to confirm that
you understand that this process does not replace the CMS requirements of
mailing in your ECR files, signed certification page and other documentation as
described by your MAC.
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Click the Agree and Continue button to continue the process. The next screen
should look familiar to you. The HFS system will create the EC and PI files, encrypt
them and create the encrypted Worksheet S for signature. The system makes the
files in your data file location and you can choose to have them copied to an
additional location as well. 

Next you will see the following SaFE information window.
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1. The EC (SN, HH, HS, RH, FQ, OP, RD, CM) and PI files have been created and
we will transmit them to the SaFE site for a validity check and storage.

2. Your HFS data file (.mcrx) will also be uploaded to the SaFE site. We
recommend that you store associated files in the SaFE. In this example the
encrypted Worksheet S will be transmitted to the SaFE for storage. If you have
used features like PS&R Reconciliation (.mcp) or the Automated Account
Interface(.aai, .aaix) we will list these files as well. We recommend saving these
as next year you will be able to download them and have a very efficient start to
next year’s cost report filing. If you do NOT want to save these files to SaFE
you can click on the file to highlight it and then click the Remove button.

3. If you have other files that you would like to save in the SaFE such as work
papers, click the Add button , then Browse and select your file. The File Type
box has drop downs for files with a .pdf, .xls, .xlsx or .*. With the additional file
highlighted, you can click in the File Note box and type in a description of your
file (up to 255 characters). The SaFE site will not accept .exe files for upload. 

4. The HFS SaFE site is not intended to store PII or PHI data. Do not upload any
file that contains PII or PHI.

5. Click the Send to SaFE button or you can change your mind and click the Skip
button and not transmit anything to the SaFE site. 

The next screen will show the storage progress.
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And then another warning regarding the fact that this process does NOT take the
place of the existing and required by law submission process. There is also an
option to Visit MAC website. This will take you to the closest we could get to your
MAC’s Medicare Cost Report mailing instructions.

Click the OK button and you will see the SaFE Storage Successful message.
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After clicking OK, you will be back to the normal ECR Export completion
information screen.

Once the SaFE site receives your files, we will notify you at the e-mail associated
with your HFSSOFT.com log in.
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And then you will receive a second e-mail after we have processed your report.
The speed of these e-mail responses will depend on the server traffic.
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To see the details of our processing or to view or retrieve your stored files, click
the HFS SaFE web portal link in the e-mail or go to https://safe.hfssoft.com/.

You will need to sign in.
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And then you will see a screen that shows your stored reports. If your account has
more than one user, submissions will be stored by user ID. If your account has
several files stored, it may be helpful to use some of our filtering options; store
date, fiscal year, provider type, provider number and the status of the pre-
acceptance.

After we receive your files, we run them through several validity checks. Click on
the Pre-Acceptance Check status to see which areas of the file passed or failed
our checks.



135Store and File Electronically (SaFE)

© 2025 Health Financial Systems Version 5.0.7

Click the arrow to see all files stored with this report. You will see the files that you
sent and the files that were created during the HFS SaFE processing.

You can click the box to the right of each file and then choose to download,
reprocess or delete it.

And if you are missing something and would like to add to this set of files, click the
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upload box option and a browse window will appear complete with an area to add
a note describing your additional file.

8 Amended Cost Reports

If you are filing an amended cost report, you will want to make a copy of the original mcrx file and

rename the file amended.mcrx.  You then open the mcrx file and open W/S S, Part I and change line

5 Cost Report Status from 1 – As Submitted to 5 – Amended.  You also need to change line 3 to 1 for

first amended report.

When you complete your changes and do the EC export, when you get to the following screen, you

keep it as 1
st

 Calendar Year Submission.  The only time you change this when you are filing 2 or

more cost reports in the same calendar year – like a 6-30 and 12-31 due to a CHOW.

Notice the extension of the EC file changes to the YYA2 (the YY is the year, A for first cost report in

the calendar year and the 2 for the 2nd filing – the 1st amended report).
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9 PS&R Reconciliation

The HFS PS&R Reconciliation tool is an integrated component of the Medicare
cost report software. The PS&R Reconciliation tool is a very efficient to import
PS&R data directly into the cost report. Provider Statistical & Reimbursement
reports ("PS&R") are produced by a standard system provided by CMS. The
PS&R system collects Medicare Part A claims data processed on the standard
claims processing system. The two primary reports produced by the PS&R system
are the Provider Summary Report and the Payment Reconciliation Report. The
Provider Summary Report contains a summary of Medicare Part A charges,
Medicare patient days, deductibles, coinsurance, payments, etc. for each provider
for a specified period of time. Providers use Provider Summary Reports to prepare
their Medicare cost reports. The Payment Reconciliation Report provides detailed
claims data that supports the Provider Summary Report.

The PS&R Reconciliation tool enables providers to prepare more accurate cost
reports and also dramatically reduces the amount of data entry required to
complete the cost report.  HFS makes this tool available to both provider and MAC
clients.  Click here for the CMS PS&R website.  This site offers PS&R extract files
as an output file option (you will need to request a csv format to import into HFS). 
These are the files that the cost report software can import into the PS&R tool.

Requirements:  You must have a Medicare cost report file (.mcr or .mcrx file) with
the correct fiscal year entered and all provider/sub-provider Medicare provider
numbers entered on Worksheet S-2. The provider component information on
Worksheet S-2 is used to match to the PS&R data.  The fiscal year information on
Worksheet S-2 will be used to split the PS&R data. Other information such as
Payment System will be used to correctly cross-reference PS&R Data.

**Examples are from the 2552-10 system, however the PS&R tool is available in all
systems. 

https://www.cms.gov/Research-Statistics-Data-and-Systems/Statistics-Trends-and-Reports/PSRR
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This screen shows an example of Worksheet S-2 with the required data entered in
the cells for fiscal year and provider numbers.

Home Health Agencies also need to enter CBSA codes prior to importing the .csv
file to ensure the correct data is imported and the appropriate crosswalk is applied
to the imported PS&R data.  HHA must enter CBSA codes in the following
worksheet locations:

Hospital based Home Health Agency data - 2552-10 is Worksheet S-4, line 20;

SNF based Home Health Agency data - 2540-10 is Worksheet S-4, line 22;

Free-standing Home Health Agency - S-3, Parts I-III line 35.

*This is available in the older mcr cost report types (i.e. 2552-96, 2540-96,1728-94
etc.)

Revenue codes are part of the UB-04 Data File.  The UB-04 data file [2024] is
copyrighted by the American Hospital Association (AHA), Chicago Illinois.  Nor part
of the UB-04 Data File may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying,
recording or otherwise, without prior express written consent of AHA. 
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9.1 Open the PS&R Reconciliation Tool

Your cost report must be open before you can start the PS&R Reconciliation tool. 
On the Tools menu, select PS&R Reconciliation. 

Note that the provider and sub-providers (and their respective provider numbers)
have been populated in the Component section of the PS&R Reconciliation
screen.  This will occur automatically when you start the PS&R feature. When you
select the PS&R Recon tool, this creates a mcp file that is outside of the mcrx file.
 The mcp file should be retained.

There are numerous options that can be selected for the PS&R. The main option to
select is under Assignments, select Always - Always.  See PS&R Options.
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9.2 PS&R Help Guide for Non-Hospital Reports

The PS&R tool for non-hospitals is simple and can be summarized below:

For 2540-10, you may need to ensure all revenue codes are assigned to the

proper cost center in the Provider Cross Reference.

9.3 Import PS&R Data

To import the PS&R data,  click on the Import Extract icon. The following screen
will appear:

The import function is context specific.  Only data associated with providers
identified in the opening screen and with dates of service that fall within the cost
report period can be imported.  To import data, click on the browse button to
locate the PS&R extract files.  The system can handle a single .txt, .prn or .CSV
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file containing all the splits or multiple files containing the splits (the CMS extract is
now csv, previously it was txt and we also allowed prn imports).  We do not expect
you to examine the files to determine if they are complete.  The system will do that
for you.

Highlight all the PS&R extract files you obtained and want to import and then click 
Open.

It is best to import the files at the same time. Trying to import files individually can
cause problems if you inadvertently import one or more files more than one time.

If you accidentally selected unrelated PS&R extract files, the files will not be
imported.  The files will be excluded from the  import because either the cost
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report period or the provider number (or both) on the cost report's S-2 did not
match the data in the PS&R extract files.  Select the files to import and click Open.

You will see the screen shown above.  The software will already have analyzed the
files you selected to import and will show you which files have data that may be
imported and will also show you any files that do not.  (See items 1 and 2.)  By
default, all components will be selected for import.  If you u-select any components
the files that have data which may be imported may change.   Only files with data
for the selected components may be imported.  There is a check box underneath
the component section.  Check the box if you want to overwrite any existing report
detail when you import the data in the selected files.  This option will wipe out any
existing report data and replace it with the data you are about to import.   Click 
Import to import data for the selected components from the extract files you
identified.

After the import is complete, the results will be displayed. Note that the five PS&R

Extract files that relate to the cost report all have a check mark  that denotes a
successful import. Note that five of the ten files were not imported.  These files are
marked with a red "X" . This is because these files did not contain data relevant
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to the cost report.  Click the Finished button and the Import screen will close. 
The Report screen will be displayed:

Note:  By clicking on a component, the reports associated with that component will
appear in the top of the screen.  Clicking on individual reports will display the report
with all the revenue codes, dates of service and PS&R amount

Revenue codes are part of the UB-04 Data File.  The UB-04 data file [2024] is
copyrighted by the American Hospital Association (AHA), Chicago Illinois.  Nor part
of the UB-04 Data File may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying,
recording or otherwise, without prior express written consent of AHA. 

9.4 Sort PS&R Data

The default sort order is by revenue code, and then by date of service.  You can
sort by any column by clicking on the column heading.

Note: There are no duplicate dates of service.
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9.5 Manually Input PS&R Data

The PS&R feature allows you to manually enter data if extract files are not
available.  To do this, click on the component that you wish to create a new report
for and the following screen will be displayed.

Here, you can create new reports by choosing from a list of standard reports (see
below).

In addition, you can create customized reports by selecting the Custom Reports
option. You will see the following screen.
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In the example above,  you entered “110XIX” and “Hosp Inp Medicaid” to create
the custom report.

Click Finished to create the new report.  The report screen for the new report will
open.  You can type data into the various cells.

You can also type data on a report that was created automatically when you
imported the PS&R data.  You may need to add amounts that were not included in
the extract file.
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9.6 Update Provider Cross-Reference

You can view and edit the Provider Cross-Reference by clicking Provider under
the heading Cross-Reference on the left side of the screen (see below).

The following picture is an example of the Provider Cross-Reference screen (the
line numbers are for the 2552-10).

The first time you view the Provider Specific Crosswalk all worksheet A line
numbers will be set to HFS's assumptions. You will customize the crosswalk for
the provider whose cost report you are preparing.  There are four columns on the
provider specific crosswalk screen: Worksheet A Line Number; Statistic Code;
Override for Part B Line Number; and Override for Part B Statistic Code. The
Worksheet A Line Number field should be filled out with the appropriate cost
center.  If the revenue code should be allocated to multiple cost centers, type "0"
for the Worksheet A Line Number and enter a statistic code in the Statistic
Code column.  (See section 7.8 for further details.)
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The Override for Part B Line Number column and the Override for Part B
Statistic Code column are used if you need to assign revenue codes to one place
for Part A reports and another place for Part B reports. These entries act as
overrides for the Part B reports and only need to be filled out if the first two
columns of information cannot be used for the Part B reports.
 

9.7 Import Provider Cross-Reference

If you used the PS&R feature in a prior year and you want to start this cost report
with the Provider Cross-Reference that you previously customized, you need the
.mcp file from the prior year.  Click the Import Cross-Reference button on the
toolbar.

The following screen will be displayed.

Browse to and select the .mcp file then click Open. The cross-reference will be
imported. Once you are satisfied with the Provider Cross-Reference, you are
ready for the next step.
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9.8 Allocate with Statistics

If you have a revenue code that should be assigned to more than one cost center
you can use a statistic.  The first step is to assign a statistic code to the revenue
code that needs to be split.  You can enter this statistic code on the report or on
the Provider Cross-Reference.

To create a statistic, click on User Defined, under the Statistics heading, to open
the New PS&R Statistic screen. Give your statistic a four character stat code and
a description.

Note: Stat codes are case sensitive.  When you use a user defined stat code you
must type it exactly as it was typed when you created it. For instance, user defined
stat code "120I" is not the same as user defined stat code "120i."

Once you have entered the code and description, click Finished.  The following
screen will appear.

Enter your allocation on this screen.  In this example, this statistic that will assign a
revenue code to cost centers 30, 31, and 35.  The allocation entered is 50, 25 and
25.   50% will go to cost center 25, and 25% to cost centers 27 and 28.  When
entering statistics, you will not include decimals, so if 45.55% enter as 4555 and if
dollar amount, either round up or down.

Note:  If you know the exact dollar amount that you wish to assign to certain cost
centers, you can enter these amounts instead of using a percentage.
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You can create splits between an actual cost center and a 999 line (e.g., No
LINE).  The 999.00 Not Allocated\Non Allowable option is at the very end of the 
Stat Setup Cost Center screen.

The PS&R feature has certain statistics that have already been defined.  Click 
System Defined and the predefined stats will appear in the top section of the
screen.  Click on individual predefined stats to show the allocations.  To modify a
“system” or a “user defined" statistic, select the statistic and modify it.

Next, assign the statistic.  You can assign the statistic to each similar revenue
code in all reports or to only one report. To add the statistic globally, add it in the
statistic code column in the provider cross-reference. Enter the statistic code in the
Allocation Basis column for a revenue code in a report when you only want the
assignment to apply to a particular report. The image below is an example of how
you apply statistics at the Provider Cross-Reference level.

 

If you want to apply the Revenue Split to Part B only, enter the statistic in the 
Statistic Code – Part B Only column.

Note:  Wherever the statistics are added, the previously assigned line has to be
zeroed and the statistic added.  The following is an example of statistic (120I) that
has been assigned to Revenue Code 120 in report 110 – Inpatient Part A:
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There are two important things to remember when entering a statistic: the statistic
code has to be entered exactly as it was set up (i.e., it is case-sensitive); and if
you are using a statistic, you must zero out the previously assigned line number.

The Difference Report will highlight the Revenue Code subject to a statistic, by
including the statistic code used next to the amount.  [See the example below.]

Note: The Revenue Code 120 in report 110 has both a “*” and the stat code 120I
to denote that a stat was used to allocate the amounts accordingly.
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9.9 Import a Statistic

You can import statistics from an .mcp file.  Click the Import Stats button on the
toolbar.

Then select the .mcp file you want to import from.

This will import the statistics from the selected .mcp file.

 

9.10 Apply Provider Cross-Reference

After you import data and setup and/or review the Provider Cross-Reference, you
must apply the cross-reference to the data associated with the various reports and

components. Click the large check mark  on the tool bar to apply the Provider
Cross-Reference to the imported PS&R data. You will see the screen depicted
below.
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Select the components you want to cross-reference and click OK.  When the
cross-reference is finished, you can change a specific revenue code at the report
level without changing  the Provider Specific Cross-Reference.  

There are options for the Apply process on the Assignments tab.  The default is
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Always overwrite worksheet and line number/stat code assignments.  This means
that if you make changes at the report level that differ from the Provider Specific
Crosswalk and then click Apply, those changes will always be overwritten.  If this
is not your intention, you can change what would be replaced.

Note:  We highly suggest to have selection Always - Always (this is under the main
Options | Preferences | PS&R Options | Assignments).

Once you complete the Provider Cross Reference, if the subunits are the same as
the hospital, you can select the Transfer Cross Reference icon and then select
subunits you want to be the same as the hospital.
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9.11 View/Print the Difference Report

The Difference Report shows the "as submitted" values, the grouped PS&R values
and the difference between the two.  You can view the Difference Report by
clicking the Difference Report button on the toolbar.

The software will produce a Difference Report for the entire facility if you select 
Components on the tree, located on the right edge of your screen.

If you select an individual component the Difference Report will apply only to the
selected component.  Whether you chose to run the Difference Report for all
components or a single component, the software will run the report and you will
see the print preview version of the Difference Report on your screen.  The
diagram below shows a print preview of the Difference Report.
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The first section, Line Not Assigned, will show any revenue codes not assigned to
a worksheet.  We recommend you review these lines to see if there are revenue
codes that need to be assigned.  If there are,  go back to either the provider
cross-reference or to the report level and assign a line number.  For revenue
codes that were successfully assigned, the report shows the PS&R amounts, the
cost report amounts, and the difference between the two.

You cannot set print options when you run the Difference Report by clicking the
button on the toolbar.  The options are accessible if you run the Difference Report
by clicking Print on the File menu at the top of the screen. For example, you can
print individual lead schedule reports, the standard or provider cross-reference,
and any statistics.  The next section discusses the print options in more detail.
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9.12 Print

Printed copies of the PS&R reports can be used as the PS&R crosswalk that
should be submitted with the cost report.  To view or modify printing options,
select Print from the File menu.

You can select one or more reports to print or print preview.  In the example
below, if the second component is selected, only the reports associated with this
component will appear.
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Likewise, if you select System Defined Statistics, User Defined Statistics, or
Cross-Reference, only reports available for printing for the selected item(s) will
appear. We suggest to select User Defined Statistics along with the Provider
Cross References:
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Select Print to File at the bottom of the dialog box to print to a PDF file.

After you click the Print to File check box and before you click the Print button,
you must specify the folder where you want to save the PDF file.  Enter the drive
letter, directory path and file name in the text box to the right of the Print to File

check box, or click the Browse button .   The example above will save the
PDF file to C:\MCRIF32\PSR\AsFiled_2017.MCRX.PSR.pdf

 

9.13 Export PS&R Data

If you are an auditor, you can export the PS&R data to the Auditor feature and
audit adjustments will be automatically created.  If you are a provider, the PS&R
amounts can be exported to the cost report. (See details below.)
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9.13.1 Export to Auditor

Before an auditor exports PS&R data to Auditor, it is important to first set-up
certain Adjustment Preferences.

One of the components of the Export to Auditor function are Audit  Adjustment
Descriptions.  Not all MACs want the same Audit Adjustment Descriptions.  To get
to the screen where you can change the descriptions, you must be in the PS&R
window.  Click Options and them Preferences and scroll down in the
Preferences dialog box and  select Adjustments under the PS&R Options
section (see above).  After setting the Adjustment Preferences, you are ready to
export the adjustments.  Note: Auditors can also reference work papers and enter
their names at this screen.

Click the Export button  and the Export PS&R dialog box will appear.
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The default is to export all components at once, but you can select individual
components to export.  The To Cost Report option will only be used by providers
to populate their cost reports with PS&R data.  MACs will select the To Auditor
option, because this will create their audit adjustments.

Selecting To Auditor moves the PS&R data into the Auditor feature.  You can print
and/or apply the Audit Adjustments.  You can also modify the Audit Adjustments.  If
you want to modify the PS&R data and re-export to Auditor, you must delete the
related Audit Adjustments.  Otherwise, you will have duplicate Audit Adjustments.

Note: When the PS&R adjustments are exported to Auditor, the adjustments follow
the same order as the Difference Report.

 

9.13.2 Export to Cost Report

If you are a provider, you will want to export your PS&R data to the cost report, so
that your cost report will be populated with your PS&R data.  To export to the cost
report, click the Export button and the Export PS&R dialog box will appear.
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Select the to Cost Report option.  By default, PS&R data associated with reports
for all components will be exported to the cost report.  You can choose to only
export data  to certain components by selecting or clearing the check boxes
associated with the individual components.   Data will only be exported for the
Components that are selected.  Click OK to export to the cost report.

Note:  If you run a Difference Report after exporting data to the cost report, the
data in the difference column will be "0" because the cost report is populated with
the PS&R data.

Note: If you export more than one time, a warning message will display the time
and date of the first export and ask you to confirm that you want to proceed with
the subsequent export.

 

9.14 "Gross Up" Charges

Often when a provider prepares its Medicare cost report, not all claims for the cost
report period have been paid.  The provider may know the total amounts of these
claims, but not the revenue codes or the cost center where the charges should be
assigned.  It is also possible that when a provider submits a cost report to a MAC,
they may have made some kind of error that can be identified in the aggregate, but
again, cannot be associated with a revenue code.
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We have included the ability to statistically allocate charges not in the PS&R file to
all cost centers based on the amounts already in those cost centers.  To do this,
you can add your own revenue code to Report 110.  In this example, we are using
GRS.  Then key in the total gross-up amount ($100,000).  Next, enter the
worksheet (D-3), program (18), component (Hospital), and column (2).  You can
view the list of existing statistics by clicking View | Statistics.  In this Example, we
chose “IC8a” because that will use Worksheet D-3, Title XVIII, Inpatient Charges,
lines 30 through 94.

 

10 Medicare Auditor

The Medicare Auditor feature was developed with input from many of our users.
This powerful tool is used by MACs to audit cost reports and by providers to
perform "What-If" analysis and to view the impact of their MAC's audit
adjustments.  We included every foreseeable capability our users may need, and
we have made those capabilities easily accessible. You access the Medicare
Auditor feature while in a cost report (.mcr or .mcrx) file. You enter adjustments
through Auditor's data entry screens.  The adjustments are stored in a file with a 
".Auditor" file name extension. You can  choose to apply all or some of the audit
adjustments. When you apply adjustments Auditor creates a copy of your cost
report and calculates the copy using your adjustments .  Auditor never modifies the
original  cost report.

If you receive an “.Auditor” file from your MAC, or another HFS user, you can view
or apply the audit adjustments in the .Auditor file to your cost report.  First, the
names of your cost report file and the .Auditor file must be the same.  For
instance, if the cost report file is named A123456.mcrx, and you receive an Auditor
file named A0_050001_12312009.Auditor, you must rename one of the two files. 
Either change the name of the cost report file using Save As, or standard Windows
commands, so that the file is named A0_050001_12312009.mcrx, or rename the
.Auditor file to A123456.Auditor.  Both files must be saved in the same folder. 
Then when you open cost report and open Medicare Auditor, the Audit
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Adjustments will already be in Auditor.

To open Auditor, open your cost report file.  Then, on the Tools menu, select
Medicare Auditor.

When using Auditor all of the cost report software functions are still available. You
can open and close worksheets, calculate, print worksheets, edit cost centers,
etc., while simultaneously viewing or working on audit adjustments.

Note: The system automatically creates a backup copy of the .Auditor file
(.Auditor_bk) in case the original becomes damaged.

 

10.1 The Auditor Screen

When you start Medicare Auditor you will see the screen below.

The Auditor screen shows up at the bottom of your regular cost report screen so
that you can still view and work on your original cost report. You can re-size the
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Auditor window by clicking on the top edge of the window and then dragging it up
or down. The system will remember your size preference the next time you start
Auditor.

Notice the tabs across the top of the Auditor screen. The system defaults to the 
Main Adjustments tab. This list shows the existing main audit adjustments in
sequential order. This screen gives you the ability to exclude or tag a Main
Adjustment, and you can see whether the adjustment has been applied. You will
find the full text of the adjustment description in the Notes text box. The first line of
the note is displayed next to each adjustment number. You can enter a work paper
reference in the Work paper text box. When you click on the next main adjustment
number, its information will be displayed in the Notes and Work paper text boxes.

When you click on the Details tab, you will be able to enter the individual detail
adjustments within each main adjustment. You can customize this screen (see the
Auditor Options and Utilities sections in this manual) with the fields with which you
want to work. All you have to enter is the worksheet, part, program, component,
line, column, action, and amount. While viewing the Details screen, you can switch
to another main adjustment by clicking on the drop-down box that shows the main
adjustment number and description.
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You can switch between adjustments by clicking on the Main Adjustment drop-
down box and selecting the adjustment.

The Auditor Toolbar on the left side of the Auditor window gives you quick
access to the following functions.

Click the Help  button  to open the Auditor section of the HFS User Manual.

 

10.2 Data Entry

When you start a new Auditor file, you will see the screen below. You can elect to
have the system start with boilerplate adjustments, from a personalized template,
or blank.



166 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

 

Auditor always displays the Main Adjustments tab on start up. To create a new

main adjustment, click on the Create New Main Adjustment button . A new
sequentially  numbered Main Adjustment will be created. Right click in the Main
Adjustment screen to see the following options.  
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Select New and the Auditor Adjustments dialog box appears. Enter a number to
create one new Main Adjustment or enter a range of numbers to create multiple
new Main Adjustments.

Auditor keeps track of the next available Main Adjustment number and will prompt
you to select that number. If you want to leave a number blank for future use, you
can key the actual audit adjustment number you want or a range of adjustment
numbers.  You can also choose Next New Adjustment from the menu, and the
system will automatically create the next sequential Main Adjustment.  You will
need to type the description of the Main Adjustment and the work paper reference.

The next step is to enter the adjustment details. Click the Details tab to switch to
the Detail Adjustment window. You can adjust any non-calculated cell in the cost
report. You can modify any type of data, including dates, text fields, and numeric
fields. When you enter the details of your adjustment,  Auditor checks to see
whether the adjustment refers to a valid cost report location.  Auditor will display
"No Errors" if the location is valid,  or "Invalid" if your Adjustment Detail refers to a
location that does not exist or cannot be modified. If you have a worksheet open,
you can click on the cell you want to adjust and then click the Create an

Adjustment from the Active Worksheet button . The selected cell’s detail
information will instantly populate the cells on the Detail line. You can even select
multiple cells to create multiple new Detail Adjustments.

Below is an Example of two adjustments that were created by highlighting
worksheet E, Part A lines 1.00 and 2.00 for column 1.00 and then clicking the 

Create an Adjustment from the Active Worksheet  button.
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The more traditional method is to click on the first “Worksheet” field in the Details
tab. If you know the worksheet you want to adjust, type the name of the
worksheet.

You can also click on the worksheet drop down box and then click the down arrow
to scroll to the desired worksheet.

Depending on the worksheet you select, the system knows whether you need to
specify a part, program, and component. If these additional qualifiers are needed,
the system will give you a pick list of allowable values for each field.
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Once the worksheet, part, program, and component are specified, the next step is
to enter the line and column. As you enter the line and column, the system will
display their descriptions. After you have entered a complete cell reference, the
system will display the Original value. If you should submit an invalid line/column
reference, the system will immediately inform you. It is possible that a line might be
valid at the time you enter an adjustment. The line could later be deleted, or the
cost report rules might change, rendering the line invalid. This error would be
reported on the Audit Adjustment report.

Another important feature of the system is that it determines the nature of the field
you have specified. The system determines whether a field is alpha, date, or
numeric. For numeric fields, the system knows the number of decimal places
needed for every field in the Medicare cost report.

The Action field can make the auditor’s job a little easier. The Action options are
Add, Replace, Memo, Comment, Del Wkst, and Del Line. An Add adjustment will
add or subtract (if the amount is negative) the amount from the current value. A
Replace option means that the value is to replace the current value. When
producing the Audit Adjustment report, the system will compute the adjustment
amount needed to get the specified replacement value. Choosing between Add and
Replace is a matter of convenience for the auditor. If you determine that a certain
amount needs to be added or subtracted, use Add. If you know the amount that
should be in the field, use the Replace feature. The system knows that you cannot
add alpha fields, dates, or line references and will ignore an Add.

When a Memo adjustment is used, the system does not apply the value. You might
use a Memo adjustment to indicate that a retroactive change in the CMS
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instructions has caused a value to change. The Comment action is similar to the
Memo action except that the information for the adjustment is not applied, nor is it
even printed on the Audit Adjustment report.

You can use Del Wkst to delete a worksheet. This option requires that you enter
the Worksheet, Part, Program and Component, if applicable. The line and column
do not have to be entered, and if they are entered, they are ignored.

Some adjustments can be very time consuming. For example, to make an
adjustment to one line on a reclassification (i.e. A-6) or an adjustment worksheet
(i.e. A-8), you need to reference several cells. HFS has special screens that
simplify this process. When you enter an adjustment for one of these worksheets,
the system will automatically bring up the specialized screen for entry. Original
data will be placed in both the Adjusted Values column and the Values column.
This makes it easy to adjust a single piece of the entry.

If you want to go back to the expanded audit detail screen, you can get there in
one of three different ways. The first way is to press ENTER while the cursor is in
the Worksheet column of the Detail Adjustment line. The second method is to
press F6 while the cursor is in any part of the Adjustment Detail line. The third
method is to click the Adjustment Detail button  on the Auditor Toolbar.

These special audit adjustment screens save considerable time. When the Audit
Adjustment report is printed, the report will show only the pieces of the adjustment
that were changed.

The HFS Medicare Auditor can assist you with the entry of audit adjustments to
Worksheet (Hospital) B-1, allocation statistics. When HFS converts an ECR file to
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a cost report file, we analyze the allocation statistics. If the same statistics are
used to allocate two columns, we only store those statistics one time. We use a
statistics code to accomplish this. All overhead cost centers are assigned a
statistics code. If the allocation statistics in the ECR file are the same for two
columns, we assign the same statistics code to both lines being allocated. When
you adjust a statistic that is used multiple times, a single change affects all columns
using that statistic. If your single adjustment affects multiple columns of statistics,
the adjustment report will show each column as a separate adjustment entry.

If you need to override the accumulated cost statistic, you enter the column and
the line you want to override. You can then enter 11- "99999999999" in the 
Amount column (as a Replace) to force the accumulated cost in that column and
line to zero. 

As shown above, the force to zero in auditor is 11 – 9’s so to remove the force to

zero and ensure the cost center is to be allocated based on accumulated cost, you

create an adjusted to replace the 11 – 9’s to 0:

10.2.1 Shortcut Keys

Opens the print dialog box.

Switch to next tab

Switch to previous tab

Switch between main and detail tab only

Opens the Go To dialog box to jump to a specific main

adjustment number



172 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

    
Move the cursor to the first cell on the row

Will create a new detail line on the detail screen

Execute the Finish or OK button in any pop-up dialog

boxes used by Auditor like apply screen

Cancel any pop-up dialog box used by Auditor like detail
screen, utilities and apply screen

Opens Medicare Auditor Help

Clear date field

Set today date in the current date field

Open the calendar for the current date field

Show the detail screen for complex worksheet
adjustments

Create a new main or detail adjustment depending on the
screen you are on

Permanently delete selected main adjustments

Jump to the main application menu bar

 

Cut/Copy/Paste Commands

In addition to the CTRL+X, CTRL+C and CTRL+V shortcut keys you can use the
relative pop-up menu commands by right clicking on selected cells.. To select rows
use the header on the left of the spreadsheet.

Create Adjustments From Worksheet

You can create adjustments by selecting a cell or a range of cells directly from the
active worksheet. Once you select cell/s use the Create adjustment from active
cell button located on the auditor toolbar for the detail screen.
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10.3 Applying an Adjustment

To apply adjustments and review the settlement impact of one or more

adjustments click on the Apply button  on the Auditor toolbar, or, on the File
menu, select Apply.

To see the impact of one or some of your adjustments, select one or several
adjustments using the Tag option. You can select or deselect an adjustment by
clicking the Tag check box in the Tag column on either the Main Adjustment
window or the Detail window. When finished selecting the adjustments you want to

apply, click the Apply button .  In the Apply Options dialog box, click the
Apply All Tagged Adjustments option button.
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To exclude adjustments, select or clear the Exclude check box for each
adjustment. The detail of excluded adjustments are not modified if the adjustment
is excluded. However, if you choose Apply All Adjustments, the excluded
adjustments will not be applied. To restore the adjustment to active status, clear
the Exclude check box.

You can delete an adjustment.  Select an adjustment.  Then on the Edit menu,
select Delete, or right click on the selected Main Adjustment then click Delete.

Note: The CMS Financial Management (Pub. 100-06) Manual requires that when
MACs give the provider an updated Audit Adjustment Report, the MAC must
identify the adjustments that have changed since the report was last given to the
provider. The HFS system allows you to mark the date of the Adjustment report as
the date the Audit Adjustment Report was last given to the provider. If an Audit
Adjustment report is run in the future, it would indicate in the audit description which
audit adjustments have been modified since the report was sent to the provider.

You can view the impact of applied adjustments by opening the worksheet where
the adjustment was applied. Next, on the View menu, click Adjusted Report. Then
open the desired worksheet to see the impact of the adjustment in the Adjusted
Report.  After this option is selected, all subsequently opened worksheets will be
from the Adjusted Report.

https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS019018
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When you open the worksheet in your original cost report you will not see the
effect of your audit adjustments because Auditor never modifies your cost report. 
However, after you open the worksheet in the Adjusted Report, you will see the
adjustment(s). The adjusted worksheet with have "Read Only" as part of the
worksheet name on the tab at the top of the worksheet window, as shown in the
picture below.
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10.4 Print Options

When you apply an adjustment, you will be presented with the options shown in the
below window. Your responses will be saved and used when printing reports until
you change them. You can make changes on this screen or click Finished to
continue with the current settings.

The first section allows you to print the reports to a printer, preview the reports, or
print to a file. If you choose to print to a printer, you can also select which printer
by clicking on the Printers button to the right. If you select Preview, you will be
able to view the report on the screen. You can still print the entire document from
the Preview window. The Preview feature has the additional advantage that you
can print a single page. You can also print to a text or PDF file. This is a useful
feature if you want to email a copy of the report.  The selected options will remain
in effect until you change them.

The next section allows you to choose what to include in the printed reports. The
first report is the Audit Adjustment Report. This report contains all the detailed
audit adjustment information and is the report sent to the provider.

The Adjustment Detail Report contains all the information in the Audit Adjustment
Report, plus the administrative information: date created, date last modified,
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auditor name, date reviewed, reviewer, etc.

The Adjustment Error report is a list of problems in the Auditor file.

If you want to see the CMS Level I edits or the HCRIS edits, you need to check
the Calculation Edits check box.

The Adjustment Not Applied Report shows a report of all adjustments that have not
been applied because they were excluded or not tagged.

The Adjustment Cost Centers Report shows all adjustments made under the 
Adjusted Cost Center tab.  Any changes made to the cost center structure or to
the cost center statistical setup will only be shown in this report.

You can choose to print the Settlement Summary and the NPR Report.

To customize your Adjustment Report, click on the Adjustment Report, and then
click on the Details button. The screen below will appear. You may start your
adjustment page number at 1 or, if you insert additional pages before the
adjustment report, you can specify a number based on the number of pages you
include. You can choose to sort your adjustments in worksheet order. If you don’t
choose this option, the adjustments will be printed in the order in which you entered
them. When you choose to sort your adjustments, the Adjustment Report will print
a reference number that will tie back to the adjustment number on the screen.

Note: If you choose to print in a certain order, the Detail Adjustment Report will
print in the same order.
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Note: The CMS Financial Management (Pub. 100-06) Manual requires that audit
adjustments should be in order by worksheet.

You can specify whether you want adjustments with no worksheet, line, and
column references (empty). If you have the three standard adjustments at the
beginning of your report, these will print even if you specify that you do not want to
print empty adjustments.

You can print the Adjustment Report cover page through the HFS system with the
option of showing how many pages are included in the report and with extra blank
lines for notations.

When printing the Adjustment Report or the Detail Adjustment Report you can
choose to print a particular group of applied adjustments.

https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS019018
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Click the check box at the top of the dialog box to enable the print filters.  Clear the
check box if you don't want to use the filter feature. You can filter by one or
multiple criteria. For example, you can select only adjustments created on
particular dates and created by a particular Auditor. The Auditor name field and
the Identifier field are case sensitive. The filter settings are saved and remain in
effect until you deselect them or disable the filter feature.  Whenever you apply
your adjustments the same filter settings are applied. The Clear button will
deselect all check boxes and data on the screen.  Whether you clear the current
filter settings or enable and enter filter settings, the changes you make in this
dialog box are only saved if you subsequently apply audit adjustments.  If you close
the dialog box without applying the adjustments, your changes will be discarded
and the options will revert to their previous state.
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10.5 Auditor Options & Utilities

You can view and set Auditor Options by choosing Auditor and Options from the
Preferences dialog box.  You can set options for each type of cost report
software subsystem. Click Options and then select a cost report subsystem and
you will see the following screen.

You can have different decisions (or template files) for each type of cost report. If
you select the Create Default Adjustments option on this screen for the 2552-10,
you will get the first three standard audit adjustments for every new 2552-10 audit
adjustment file you open. If you do not want to include these three standard
adjustments, leave the box unchecked. If you want to have a different set of default
adjustments, put those adjustments in a file and select the Use Template File
option. You can then have standard adjustments with exactly the wording you
want. You can enter the file name for the template file or use the Browse option to
locate your template file.

Although the design concept was to use a consistent template file to preset a small
number of audit adjustments, the template file specified can contain an extensive
number of adjustments that will all be put into the new file. Also, the template file
name can be changed for each cost report type. Now click on Detail Headings.

Auditor Utilities is accessed by clicking the  icon or by going to Options |
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Auditor Options.

You can pick and choose which fields you want displayed on the Detail tab. The
Additional Headings pick list displays the fields that are not currently displayed,
and the Current Headings pick list shows fields that will be displayed. Use the
right and left arrow buttons to move the fields between the two lists. You can also
choose the order in which the current headings are displayed. Use the up and
down arrows to the right of the Current Headings list to change the field order.

Now expand Auditor Utilities and click on Auditor Name. You can enter your
name and indicate whether you want your name associated with the adjustment
when you create new adjustments and/or when you modify adjustments. You will
be able to see your name and the date on the screen for each audit adjustment
that you have created or modified. You can print this information by choosing to
print the Audit Adjustment Detail report.



182 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

The Identifier Information section provides an optional level of detail. You can use
identifier information to associate a group or team of auditors. Multiple auditors can
have the same identifier. If you enter an identifier, you should check both the new
and modified boxes. As with the auditor name, the identifier will be updated
whenever you create or modify an audit adjustment.

The Update Existing Adjustments options at the bottom of the Auditor Utilities
dialog box allows you to enter your name and then update either all or just the
empty adjustments by clicking the Update button.

See also:        Auditor Options

 

10.6 Importing Adjustments

Some Contractors have established a list of standard audit adjustments with
descriptions, references, and affected worksheets, lines, and columns. You have
the ability to import these adjustments. You can mark single or multiple
adjustments in the Adjustments to Import field, or you can use the Select All
option to mark all adjustments. When you click on the right-facing arrow, the
highlighted adjustments are added to Current Adjustments list.
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If you have deleted adjustments (not excluded, but actually deleted), you can have
the adjustments fill those empty positions by clicking the Insert into Empty
Positions option. Usually, you would click on the Append to End option to have
the adjustments add to the end of the Current Adjustments list.

We have added the ability to avoid importing empty adjustments (no worksheet,
line, and column details). At any point in the process, you can renumber the
adjustments using the 1–999 button. The Undo button to the right of the 1–999
button will undo all the changes you have made since selecting the Import Auditor
Adjustments option. You can also select Cancel to abort this process. This is a
very powerful capability. However, mistakes can be difficult to reverse. You may
want to experiment with this capability before you use it on a Medicare cost report.

 

10.7 Reorganizing Adjustments

The Reorganize utility eliminates all excluded adjustments and sequentially
renumbers the remaining adjustments. You can also reorder the adjustments. You
can click one or several adjustments. You can then move the highlighted
adjustments up or down using the up and down arrows.
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Note that the icon to the left of the adjustment number is sometimes blank and
other times it has writing. The icon is blank when there are no detail (worksheet,
line, and column) entries. The icons for the remaining adjustments contain lines.
This indicates that there are detail entries for these adjustments.

 

10.8 Add/Delete Cost Centers

You can add and delete cost centers by clicking on the Adjusted Cost Centers
tab. You can use the Add Lines fields to add single or multiple lines. If you want to
allow the addition of sub-lines, click on the Include Sub-Lines check box. Without
this box checked, the system will not add any sub-lines. After you have entered the

desired lines\sub-lines to add, click the Add button .

You can delete lines by clicking on the line you wish to delete and then clicking the 

Delete button .

You can also use this screen to change the statistic codes.
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10.9 Move/Change/Combine

The Move/Change/Combine utility moves data from one cost center and either
adds it to the data in another cost center or replaces the existing data in the other
cost center.

Here, you can “add” the data from one cost center to another, or; “take” the data
from one cost center and replace the data in another cost center (overlay).  When
you use either of these functions, the source line (From) in the Adjusted Report will
be deleted.  To use this feature, enter the cost center line you wish to take the
data from (From) and then enter the cost center line you wish to add/replace (To).

Click the Add button  to add the data from the “From” line to the data in the

“To” line.  Selecting the Overlay button  will take the data from the “From” line
and replace it over the data in the “To” line.



186 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

In the above example, the data in cost center line 1.00 will be added to the data in
cost center line 2.00 and cost center line 2.00 will be deleted.

To undo an action, simply click on the Left Arrow.  This will remove the “add" or
"replace” command and the cost centers will revert to their original state.

 

10.10 Impact Report

The Impact Report determines the impact of each audit adjustment.  To run the

Impact Report click the Impact Report button .

The Impact Report Print Options dialog box will give you the option of printing to
a printer, previewing the report on the screen, or printing it to a file. You may also
choose to print the cost centers report with your Impact report.

The last option in this dialog box allows you to select an Impact Report showing
individual results or a cumulative result.
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For example, for an Impact Report on a file that has 3 adjustments, the cumulative
Impact Report will create a report that depicts the impact first for adjustment
number 1, then the impact of adjustments 1 + 2, then the impact for adjustments 1
+ 2 + 3.

An Individual Results Impact Report will produce a report showing the impact of
only adjustment 1, then the impact of only adjustment number 2, and finally the
impact of only adjustment 3.

You can “reprint” the Impact Report from the last time it was generated.  This
allows you to print the Impact Report without having to reapply the adjustments.

 

10.11 Same Cell Adjustments

Navigation:  Medicare Auditor >

Same Cell Adjustments

Auditor can identify all adjustments to the same worksheet, line, and column (cell).
To run this utility, select a line in the Detail Adjustment section. Then click the 
Same Cell Adjustment button.  Notice how the screen below shows both audit
adjustments that affect Worksheet A, line 6.00, column 2.00. The window shows
you the amounts and the actions that have affected the cell. The New Value
amount at the bottom of the window is updated as you enter data. Note that same
cell adjustments are also referenced on the actual Audit Adjustment report.
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11 Management Reports

The Management Reports feature was redesigned for the 2552-10 software. 
Providers and MACs both use Management Reports. MACs usually refer to the
reports as Uniform Desk Review (UDR) reports.  The Management Reports
feature produces a wide variety of reports using data from one or two cost
reports. Some reports are single year reports.  Single year reports provide
information from a single cost report.  Single year reports do not perform
comparisons.  Most management reports are comparison reports.  These reports
gather data from two cost reports and perform various analytical functions.  The
reports that are compared are referred to as the Current Year report and the Prior
Year report.  These names are for convenience only.  The Prior Year report does
not have to be older than the Current Year report.  You can only compare similar
cost reports, i.e. hospital to hospital.  You cannot compare dissimilar reports, i.e.
hospital to SNF.  You can compare cost reports (.mcr or .mcrx) to adjusted cost
reports (.mca or .mcax).

To open Management Reports you must have a cost report open.  If a cost report
is not open, the Management Report option is not available on the Tools menu. 
To open Management Reports select Management Reports from the Tools
menu.  The Management Reports window will appear on your screen.
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The cost report file(s) must be calculated. If one or both cost report files are not
calculated when you start Management Reports the software will detect the
problem and prompt you to calculate the report(s).

 

11.1 Specifying Prior Year & Current Year Files

Click Settings to see detailed information regarding the Current Year and Prior
Year files.   The Current Year file will always be the cost report file that was open
when you started Management Reports.  If the Prior Year file is not specified, click
the Browse button or the Select PY File button and select the file you want to use.
 If the text that identifies the Prior Year file is red, the specified file was not found.
 Before you do anything else, you must click Browse and select a valid Prior Year
file to use for comparison.  There is also an option to clear the prior year file.
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Note:  When the cost report periods are not the same, the system makes
appropriate adjustments to the comparison data.  The software calculates the
number of days in each cost report period and uses the resulting ratio to adjust the
Prior Year cost report data.  For example, if the Current Year file cost report
period is six months and the Prior Year file cost report period is one year, the
software will reduce the Prior Year data values by applying the ratio of days, which
in this example will reduce the Prior Year data values by 50%.  If the Prior Year
file cost report period is six months, the inverse ratio is applied, and the Prior Year
data values will be doubled.  The Current Year file cost report data is never
adjusted in this process.  The adjustment ratio is only applied to the Prior Year file
cost report data.   The system will not perform the  adjustment if the  variance
between the two cost report periods is six days or less.
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11.2 Cost Center Matching

Many comparison reports require similar or matching Worksheet A cost centers in
the Current Year and Prior Year files.  Any cost centers that are not matched to a
corresponding cost center in the other file will not be compared.  All data in an
unmatched cost center is excluded from comparisons.  Therefore, it is important to
match all or almost all cost centers before you run reports.  Open the Cost Center
Matching screen by clicking the Cost Center Matching button.  The following
screen appears.

In the example above, the Current Year file has subscripted cost centers that have
no matching cost center in the Prior Year file.  You can usually match these
unmatched cost centers by assigning an appropriate parent line number from the
Current Year file.  If there is no matching cost center in the Current Year file you
should leave the dissimilar cost centers unmatched and the cost centers will not be
compared to any cost centers in the Current Year file.  To assign an unmatched
Prior Year cost center to an unmatched Current Year cost center, click on the
Prior Year cost center and drag and drop it on the Current Year cost center.

Note: If the Prior Year report had an unmatched cost center parent line that is not
present in the Current Year, leave it blank. It will not be used in comparisons.
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In addition, clicking on the Reset Cost Center Matching button, located in the
upper right corner of the Current Year cost center window, reverses any changes
you made to the cost centers and everything reverts back to its original state.  You
can return to the Report view by clicking on the Report tab.

 

11.3 Cost Center Filters

We recently added the ability to use cost center filtering in addition to tolerance criteria. 
Cost center filtering allows you to include or exclude certain cost centers from your
comparisons, regardless of tolerance criteria.  Click the Cost Center Filters button to view
this feature. To enable cost center filtering, select the appropriate filter under the
Tolerances CC Filters tab.

Selecting Cost Center Filters allows you to create custom filters based on any cost center
based management report.  Below is an example of a cost center filter that would select
only cost centers that exceed 1% of total Worksheet B costs.

Those cost centers which meet or exceed the criteria will be used in subsequent
management report comparisons.  

The second option for cost center criteria is the Custom option.  If you select Custom, you
can pick and choose which cost centers will be used in comparisons by selecting one or
more cost centers by checking one or more check boxes.  No percentage or other criteria is
applied when this option is used.

 

11.4 Specifying Tolerance Criteria

Tolerance criteria must be entered before reports are run or printed.  If no
tolerance criteria are specified and you run or print reports you will not see any
data on the reports you run or print.  However, if you select the option to "Print
Excluded Lines", you can run and print any report and all lines of data will be
included.

Tolerance criteria can be set for individual reports or globally.  To set the tolerance
criteria for a specific report, select a report by clicking on it.  The tolerance criteria
window for the selected report will appear.  In the example below the “Other
Expense" is selected.
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Note: Tolerance criteria do not apply to single year reports.  Tolerance criteria may
be set globally or for individual reports.  You cannot set tolerance criteria for a
group or category of reports.  You can use Global Tolerance Criteria to set
Tolerance Criteria for groups of reports.

There are several types of tolerance criteria.  The first is Unit Difference.  The Unit
Difference is the difference between last year's and current year’s amounts.   If the
Unit Difference tolerance criteria is 15,000, any line that changed more than 15,000
will be printed or flagged.

The next type of tolerance criteria is Percent Difference. If the criteria is 15%, only
those lines that have changed 15% or more will be printed or flagged.

The third and least commonly used tolerance criteria is Difference of Percents. 
This type only applies to Worksheet B-1 Management reports.  On the
Management Report for Worksheet B-1, report 85, there is a column which
computes the percent of the total allocation statistic for each line.  For example, if
one year a provider allocates equipment depreciation on square feet and then next
year on dollar value, the comparison of the values could be very large.  However,
the change in the percents between the years is more indicative of the actual
impact on the allocation.  This percentage is the number used in the Difference of
Percents criteria.  In the example above this criteria is available because report 85
is the selected report.  The criteria will only appear as an option when a worksheet
B-1 report is selected, or when you enter global tolerance criteria.
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If you specify multiple criteria, you have the option of evaluating the criteria
conjunctively (AND) or disjunctively (OR).

Notice that you can have a completely separate Tolerance Criteria for Capital Cost
Centers (Worksheet A, lines 1 through 3).  This allows you to specify a more
restrictive Tolerance Criteria for Capital Cost Centers since capital costs have
been passed through in previous years. To clear all tolerance from all reports or
selected reports, click the button in the upper right corner. (See red circle.)

 

11.5 Global Tolerance Criteria

Entering Tolerance Criteria for each report can be very time consuming because
there are so many reports.  To apply Tolerance Criteria globally to all reports, or a
selected group of reports, use Global Tolerance Criteria.  To use this option, click
on the Global Tolerance Criteria tab.
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Enter the desired Tolerance Criteria.  When finished, select All Reports or
Selected Reports. To apply the Global Tolerance Criteria click Apply.

Once the Tolerance Criteria have been set-up and applied, you can save them as a
template for future use. Click Settings. At the bottom of the Settings screen, under
the heading Menu File, click the Save button to save all your criteria in a menu file.
The extension used for the file is system specific.  For the Hospital 2552-10 form
set, the extension is ".255210mrx".  You can also load previously saved menu files
by clicking the Open File button under the Menu File heading.  Select the menu file
and click Open and the Tolerance Criteria will be applied.

11.6 Printing Reports

To print one or more Management Reports select Print from the File menu while in
the Management Report feature.  The Print Management Reports dialog box will
appear.
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Select which reports to print by checking the appropriate boxes.  There are several
options buttons at the top of the dialog box.  Button 1 expands all branches of the
list of reports.  Button 2 collapses any open branch levels.  Button 3 selects all
reports.  Button 4 clears all check boxes.  Button 5 prints the selected report(s) to
a file.  Button 6 prints all lines of data, including those lines that did not meet or
exceed your tolerance criteria.  You can print or preview the reports.

 

11.7 Running Reports

To create one or more on-screen reports you “run” the report(s).  Select the
report(s) you want to “run” by clicking on the report(s) in the left column of the
report screen.  When you  select a report it appears in the Selected Reports
column. You can select one report or multiple reports.
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In the example above, we selected two reports: 51and 59.  After you select the
reports you want to see, click Run Reports.  The following screen will appear in
the main window and the selected report(s) will be displayed.

In this example two reports were selected and run. The selected reports were
created and are available by clicking on the respective tabs.  You can switch back
and forth between these reports by clicking on the various tabs.

 

11.8 User-Defined Groups

You can save the currently selected reports and any applied tolerance criteria as a
group of reports by clicking the Save As Group button.

Enter the name for your group and click OK. The name of the group will appear
under the heading Report Groups, at the top of the list of reports.   In the example
below, a Report Group named New Group was created and now appears under
the Report Groups heading.
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Add or remove reports from the group by selecting the  group and then selecting
reports.  Reports will be added to the group as you select them. Remove reports
in the group by selecting them from inside the Selected Reports window and
dragging them out of the window. You can rename groups and delete groups by
clicking on the appropriate button.

User-defined groups are saved in the template file (menu file). You can share
report groups sharing copies of Menu files. If you share a copy of your Menu file(s)
with someone else they can open the Menu file and will be able to use the report
groups and tolerance criteria saved in the Menu file. There is not limit to the
number of Menu files you can create.

 

12 Data Extractor

For several years our focus was helping clients get data into their Medicare cost
reports.  Then we started getting requests from users to get data out of the
Medicare cost report.  In response to that demand, we added the Data Extractor
feature.  You can extract any data in the cost report – entered or calculated.  The
data is extracted and formatted in a comma separated file (.csv).  That file can be
imported into Excel or any other spread sheet program.

Data Extractor extracts data from a single Medicare cost report.  The Data
Extractor is also used to build the specifications for our Batch Data Extractor.  The
Batch Data Extractor applies the extract specifications to multiple cost reports. 
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The Batch Data Extractor instructions can be found in the next section of this
manual.

To use Data Extractor, the cost report software must be running and a cost report
file must be open.  Start Data Extractor by selecting Data Extractor from the
Tools menu.

Data Extractor will extract whatever data you want.  You create an Extract
Specification, which is a line by line instruction that tells the software what data you
want to extract from the cost report.  You will see window where you create or
edit specifications on the bottom half of the screen.  The top half of the screen will
still be available for viewing worksheets. This can be very helpful when determining
exactly which Worksheets, lines and columns you want to extract.  You can see
the worksheet on the top of the screen and enter the reference information on the
bottom of the screen.
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See also        Batch Data Extractor

 

12.1 Extract Specifications

The first time you access the Data Extractor, the system will set up a default
Specification Group.  The default Specification Group is the based on the cost
report form set number followed by “.csdx” (e.g., hospital is 2552-10.csdx). This is
a file on your hard drive in the same folder as your cost report software (usually c:
\MCRIF32).

In addition to specifying a Specification Group file name, you will need to enter a
name for each extract project. In fact, if you have not previously created a Project
Specification, the system will prompt you for a name when you launch Data
Extractor.  Each Specifications Group can have many extract project
Specifications.  There will not be a separate file for each project Specification. 
You can have multiple Specifications Groups.  You might have a budget group, an
audit group, etc.  Within the budget group, you might have a wage specification
and a depreciation specification.



201Data Extractor

© 2025 Health Financial Systems Version 5.0.7

Many of our clients created extracts in earlier versions of the software.  You can
still use these extracts by clicking the Open button on the Data Extractor toolbar.

You will need to change the Files of Type to the Old Data Extractor Files.
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Then you can browse and locate and select your old extract specifications.  Once
you select a file, the system will make a copy of that file in the new format (.csdx).
 Any changes that you make will only be in the new extract file format.  The old
format (.csd) extract specification file will still be available in its original form.

 

This same screen can be used to create a new Specification Group or to open
existing Specification Groups.  To create a new Specification Group, click on the
Open Folder Icon as you would to access old format specifications, but leave the
Files of Type set to New Data Extractor Files.  Enter a new file name in the file
name box.  You can now create one or more project Specifications for that
Specifications Group.

To open an existing Specification Group, you can use the browse capabilities of
this window to select the drive and folder for the desired Specification Group.  The
system will only display those files with the .csdx file extension.  Select the
Specifications Group that you want to use by double clicking on the Specification
Group name or click once on the name and then click Open.

Once you have selected the correct Specification Group, it's time to enter
Specifications.  There are two ways to start a new Specifications project.  You can
click on the New Specification button or you can click the New tab at the bottom
of the Data Extractor window.  Either of these will allow you to enter a new
Specification name.
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Enter a name in the New Specification dialog box and click OK to save the name
and close the dialog box. The name can have spaces and special characters. 
Remember the Project Specification name is one project in a Group Specification. 
Each Group Specification can have multiple projects.  The Group Specification
name is a file name.

You can delete a Project Specification using the Delete Specification button .
 Click the Delete Specification button and the current specification will be deleted.

Whether you select Create a New Specification or Open an Existing Specification,
you will see the following screen.

This screen allows you to identify the cost report elements you want to extract. 
You must completely identify the data elements you want to extract.  If the
worksheet you select has multiple parts, those will be listed in the Worksheet pull
down.  For example, you would enter or select Worksheet D, Part V.  If the
Worksheet can have multiple occurrences (programs and components), the system
knows this and will allow you to specify on of the appropriate programs (Title V,
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XVIII or XIX) and component (hospital, sub provider, SNF, etc.)

You can use wild cards to simplify entry of project specifications.  If you want to
extract all Worksheet A, Administrative and General costs, you would need to
specify all possible subscripts of line 6 (6.01, 6.02, etc.).  Instead, you can enter
line 6.99.  That will extract all subscripts of line 6.  If you wanted to extract an
entire worksheet, you can specify line 999.99 and column 999.99.

Notice the tabs at the bottom of the screen.  These can be used to change from
one data extract to another.

 

12.1.1 Selecting Output Options

There are several options regarding the format of your extracted data. To view and
select Data Extractor options, click the Options button on the Data Extractor
toolbar.

The Data Extractor Options dialog box will open.
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The first option determines if the output file will include zeros and spaces for
fields in the cost report that did not contain data or contained zeroes. Select 
Extract only lines containing data to omit lines without data from your
output file. The Additional Extracted Fields options allow you to automatically
extract the file name and/or cost report fiscal year end date and embed that
data in each line of extracted data.  This is a very useful option because it
helps identify the source of the extracted data.  After you choose the options
you want, click OK.

 

12.2 Extracting Data

When you have finished entering your project extract specifications, the next step is
to extract the cost report data.  Click the Extract button.

You will be prompted to enter a file name for your output file.



206 HFS Medicare Cost Report Software

© 2025 Health Financial Systems Version 5.0.7

This window will allow you to specify a name for the file where, you want the file
written and the format of that file.  Select the file type in the Save As Type list. 
Click Save,  and your extraction specification will run and the output file you
specified will contain your results.  A file with lines of data like this will be
produced:

 
A 37.00 1.00,3023260
A 37.00 2.00,805780
A-8 30.00 3.00,""
A-8-2  4.00 4.00,38860
B-1 37.00 3.00,23090
B-1 37.00 4.00,419410
B1 37.0027.00,3829040
B2 37.0027.00,""
B3 37.0027.00,""
C1 37.00 1.00,7194864
D-4181 37.00 2.00,3640574
D5181 37.00 2.00,3077773
D5181 37.00 2.01,""
D5181 37.00 3.00,""
EA181  7.00 1.00,""
EB181 10.00 1.00,7388617
E-1181  1.00 2.00,20225653
E-1181  1.00 3.00,"00/00/00"
 

Notice that there is only one comma in this file.  All worksheet identification data is
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located to the left of the comma. This is done to simplify searching for data in
Excel.  If the extracted data is formatted as text, date, or if there was no data in
the specified location, the extracted data will be enclosed in quotes.

 

13 Batch Data Extractor

Batch Data Extractor is a useful adaptation of the HFS Data Extractor tool.  Like
Data Extractor, with Batch Data Extractor you can extract data from a cost report.
The data is extracted and formatted as a comma separated file (.csv) file  that can
be imported into Excel, or any other spread sheet program.

Unlike Data Extractor, Batch Data Extractor extracts data from multiple Medicare
cost reports. The Batch Data Extractor applies extract specifications to multiple
cost reports.  The extract specifications are determined by the software user. 
Search criteria are used to determine which cost reports to extract data from. 
Specifications are used to determine what data will be extracted from the selected
cost reports.

To use Batch Data Extractor, the cost report software must be running.  Do not
open a cost report file. Start Batch Data Extractor by selecting Batch Data
Extractor from the Batch sub-menu on the File menu.  Non-batch Data Extractor
is started from the Tools menu.  Because of the “batch processing” capabilities of
Batch Data Extractor, the feature is assigned to a location shared by other “batch”
functions.  The picture below depicts the location of Batch Data Extractor on the 
File menu.
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Batch Data Extractor will start up and you will see the Batch Data Extractor
screen. The picture below shows the opening screen.

 

See also        Data Extractor

 

13.1 Search Criteria

On the left side of the screen there is a column which contains selector buttons for
the various cost report software modules.  The first in the list is the 2552-10.  In
the example below, the 2552-10 cost report type is selected.  When a cost report
type is selected the three configuration sections: Search Criteria, Data
Specifications and Data Extraction appear immediately below the selected cost
report type.



209Batch Data Extractor

© 2025 Health Financial Systems Version 5.0.7

In the screen shown above, there are five screen elements identified.  The first
area, “A”, is the group of selector buttons discussed above, and the three
configuration sections.  The default is the first item in the group, Search Criteria. 
Click Search Criteria to view the Search Criteria screen (displayed above.)
Because it is the default selection, it is the screen you will see first whenever you
select a cost report software type in the left column and when you start Batch
Data Extractor.

"B" is the Search Criteria screen.  This section contains various controls that allow
the user to specify criteria the system should use when finding matching files. 
Remember that this section is not where you specify what data you want to extract
from the files.  This is where you specify which files data will be extracted from.

You can elect not to specify any criteria here, in which case the software will use
all files in a specified location.  To use file selection criteria, select the option
labeled "Use search criteria when searching for matching files." You can
search by provider number and/or fiscal year end dates.  In the provider number
line, you can specify the beginning and end of a potential range of provider
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numbers.  In this example, the range is limited to only one provider number.  In the
fiscal year end line you can enter a beginning date and an ending date for a
potential range of fiscal year ends.  In this example, files with a fiscal year end
date as early as 05/08/2018 and as late as 05/07/2019 may be included in the
batch extract.

Beneath the provider number line and the fiscal year end line is a table where you
can specify Custom Search Criteria ("C”) that will be used when selecting those
files to include in the batch extract.   On each of the lines in the table, you can click
on the line in the Identifier column and you can select from a list of criteria. 
Possible selections are FYB, FYE and Provider Number.  For FYB and FYE you
can select an operator in the OP column of either greater than, less than or equal
to.  You indicate the value to be used for the comparison in the Value column.  
For Provider Number, the only available option in the OP column is "=".

Immediately below the Search Criteria input table are four buttons.  (“D.”) The 
Open button allows you to select and open a search criteria file.  A search criteria
file is a saved instance of search criteria. It is a template that can be used over
and over to select cost reports with certain characteristics.  The Save As button
enables you to save the currently specified search criteria in a search criteria file,
with a .dsc extension, for future use.  The Clear button clears all text from the
Search Criteria input table.  The Define button opens up another specification
screen.

The Search Criteria screen allows you to specify data within the cost report that
must match the criteria for the cost report to be included in the batch extract. 
Enter the worksheet, program (where applicable), provider (where applicable), line
number, column number and other details (where applicable).  After you have
defined a field it can be used on the previous screen as an “identifier” and included
in the Search Criteria.  These criteria will be compared to the data contained in the
group of potential cost reports that may be included in the batch extraction to help
determine which reports will be used and which will not.
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13.2 Data Specifications

The second configuration section in the left column of the main screen is Data
Specifications.

When this screen is opened for the first time, you will be prompted to enter the
name for your new Data Specification.  You may also choose to reset, or clear, all
Data Specification and start from scratch. If you previously created a Data
Specification, you can click Open and select the file you want to work with.

 

13.3 Specification Groups

Specification Groups

This topic is identical to the material covered in the Data Extractor section.  If you
read that section already, you may wish to skip ahead to the next topic. Each
Specifications Group can have many extract project Specifications. There will not
be a separate file for each project Specification. You can have multiple
Specifications Groups. You might have a budget group, an audit group, etc. Within
the budget group, you might have a wage project specification, a depreciation
project specification, etc.
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Before we go any further, let’s address backward compatibility. We know that
many of our clients already have set up extracts in older versions of the software.
You may access these extracts by clicking the Open button. The following screen
to be displayed.
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You can then use this open file window to locate and select the old extract
specifications. Once you select a file, the system will make a copy of that file in the
new format (.csdx). Any changes that you make will only be in the new extract file
format. The old format (.csd) extract specification file will still be available in its
original form for use with older software.

The same screen can be used to create a new Specification Group or to open
existing Specification Groups. To create a new Specification Group, click on the 
Open Folder icon as you would to access old format specifications. Enter a new
file name in the File Name box. You can now create one or more project
Specifications for that Specifications Group.  To open an existing Specification
Group, you can use the browse capabilities of this window to select the drive and
folder for the desired Specification Group. Select the Specifications Group that you
want to use by double clicking on the Specification Group name or click once on
the name and then click Open.

Once you have selected the correct Specification Group, it is time to enter project
specifications. Click the New tab in the lower left corner of the Data Extractor
window. This will allow you to enter a new project Specifications name. The name
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can have spaces and special characters. Remember the project Specification
name is one project in a Group Specification. Each Group Specification can have
multiple projects. The Group Specification name is a file name.

You can delete a project Specifications using the Delete Specification (paper with
a red “X” through it) icon. Simply click on this icon and the form appearing in the
specifications window will be deleted. Whether you select Create a New
Specification or Open an Existing Specification, you will be see the following
screen.

This screen allows you to identify the Medicare cost report elements you want to
extract. You must completely identify the data elements you want to extract. If the
worksheet you select has multiple parts, those will be listed in the Worksheet pull
down. For example, you would enter or select Worksheet D, Part V. If the
Worksheet can have multiple occurrences (programs and components), the system
knows this and will allow you to specify one of the appropriate programs (Title V,
XVIII or XIX) and component (hospital, sub provider, SNF, etc.)

We have given you some shortcuts to simplify the entry of the project
specifications. If you want to extract all Worksheet A, Administrative and General
costs, you would need to specify all possible subscripts of line 6 (6.01, 6.02, etc.).
Instead, you can enter line 6.99. That will extract all subscripts of line 6. If you
wanted to extract an entire worksheet, you can specify line 999.99 and column
99.99. Notice the tabs at the bottom of the screen. These can be used to change
from one data extract to another.

When you have finished entering your project extract Specifications, the next step
is to export the cost report values. This can be done by clicking on the selector tab
at the left of the screen labeled Data Extraction.  The following window appears.
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You can select the type of files to extract data from.  Currently the options are
.mcrx and .mcax files.  Both of these are selected by default.  Next you must either
specify a location, such as a directory or disk, where the files are located, or
specify the names of files to be included in the extract. Then choose a Data
Specification from those that have been defined and saved.  If you click Options,
the following dialog box appears.
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You may choose to limit extraction to only lines that contain data.  You may also
choose to include the cost report file name and the fiscal year end date as part of
the data extracted from the cost reports. When you are finished, click OK.

Next select the type of output file.  The default is comma separated value file, and
that is the one we will use for this example.  Next click Extract.  You will be
prompted to enter a file name for the extract file.  Click Save.  The extract will
proceed and you will see a dialog box that will provide information about the
export.  When finished click Close.

The following is an example of the contents of the file that will be produced:

 
A 37.00 1.00,3023260
A 37.00 2.00,805780
A-8 30.00 3.00,""
A-8-2  4.00 4.00,38860
B-1 37.00 3.00,23090
B-1 37.00 4.00,419410
B1 37.0027.00,3829040
B2 37.0027.00,""
B3 37.0027.00,""
C1 37.00 1.00,7194864
D-4181 37.00 2.00,3640574
D5181 37.00 2.00,3077773
D5181 37.00 2.01,""
D5181 37.00 3.00,""
EA181  7.00 1.00,""
EB181 10.00 1.00,7388617
E-1181  1.00 2.00,20225653
E-1181  1.00 3.00,"00/00/00"
 

Notice that there is only one comma in this file. All worksheet identifier information
is located to the left of the comma. This simplifies searching through the extracted
data. If the data is text, or date formatted, or if there was not data to extract on
that line, the extracted data or null value will be enclosed in quotes.
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13.4 Data Extraction

The third configuration section is Data Extraction. Click Data Extraction to open
the Data Extraction screen.

 

The first step is to choose the type of cost reports you want to extract data from. 
Select a type of cost report from the Data Source Type list.  Next, select the data
source.  You can select data from all cost reports in a folder or select specific cost
report files to extract data from.  Select one option and then identify the folder or
the cost report files.

The third step is to select a Data Specification.  Choose a specification from the
list of available specifications.  You can also click Options to open the Data
Extractor Options dialog box where you can select the options discussed in the
previous chapter.

The final step is to select the output file type from the list of file types.  After you
select the type of file, click Extract to extract data and create the output file.
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14 Automated Account Interface

The most time-consuming part of preparing a Medicare cost report (excluding the
data collection) is data entry. So, it is important to use every available tool to
reduce that burden. The Automated Account Interface was designed to reduce
data entry to an absolute minimum. AAI allows you to import a .csv or .xls file,
cross-reference your data and then export it to your cost report. AAI is designed to
automate the mass-download of data from a provider’s general ledger, organize
and map that data and export the data to any data entry enabled cell in the cost
report.

The AAI screen allows you to get to all of the main functions of the system with the
tool bar buttons.  You can navigate between screens by selecting them in column
on the left side of the screen.  While using AAI you can work on your cost report in
the top half of the cost report window. 

The AAI information is stored in a file with an extension of .aaix. If you used the
AAI feature in older versions of our software you will be able to open your AAI files
and the system will convert them to the new .aaix format.  The Automated Account
Interface is available in the 2552-10/96, 2540-10/96, 265-11/94, 1728-94, 2088-
17/92, 222-17/92, 1984-14/99, 216-94, 224-14, CHDRX, LTCIR/X systems. 

 

See also:        Batch AAI

 

14.1 Import

To import the file that you have created from your general ledger system or other
accounting software, click the Import File button on the tool bar. 
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Select the Files of Type box to select either a .csv, .xls or .AAI file. 

Next, the Import Wizard will let you choose a file layout or define your file layout if
it does not match one of the options. 

The HFS pre-defined file formats are for .csv files in the following formats: 
1. Account,Sub-account,Dollars 
2. Account,Sub-account,Dollars,Account_Names,Sub-account_Names 
3.  Account,Sub-account,Dollars,Account_Names,Sub-account_Names,
Cross_Reference_Data 

All formats assume that the fields are separated by commas. You should not have
commas in the Account Name or Sub-account Name fields.  You cannot have
commas or dollar signs in the Dollars field. 

In the second format, the system will determine whether you have one or two
account names. If you have two account names, they will be stored as the Main
Account and Sub-account names.  If you only have one name, the system will store
it as the unique label for that combination of account and sub account. 
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The third option when importing will allow you to import the cross-reference data. 
The cross-reference data must contain six components separated by commas: 
Worksheet, Part, Program, Component, Line and Column.  If the Worksheet does
not have a Part, Program or Component, leave the cell blank.  Entering the cross-
reference data requires some familiarity with the system.  If you are not sure what
needs to go into the cross-reference values, go into the Automated Account
Window, open a Workbook, click on a worksheet cell, scroll, and select the
required worksheet, and select correct Title and Component you are looking for.
Then, enter EXACTLY as you see in the cells (more so, for component selection). 
The following are some examples of cross-reference data. 

Worksheet A, line 1, column 2: “A, , , ,1,2” 
Worksheet E-3, Part III, Title 18, Hospital, line 4, column 1: “E3,3,18,Hospital,4,1” 
Worksheet E-3, Part III, Title 18, Subprovider - IRF, line 7, column 1: “E,3,18,
Subprovider - IRF,7,1” 

If your file is not in one of the formats above, then select “My data is in a format
not described above.”  You can then tell the system how the fields in your file are
organized.  

The system will read your file and show the first record in the Sample Data
column.  Go to the Data Type column and click the down arrow to see the list of
expected fields and choose the field that matches the Sample Data.  If the field
should not be imported leave the Data Type set to Do Not Import (Skip). 

You can Save this Specification by clicking the Save As button and use this the
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next time you want to import a file in this format.

The Import Wizard asks you to choose a destination and action for the imported
data.  

If you will be importing one file the default destination, Workbook 1 and Sheet 1,
should be left as is. 

If you have multiple files to import and you want to be able to view them, cross-
reference them and export them individually then you should choose separate
Workbooks or Sheets. When importing the data, you have four “Action” options. 
The first and fourth options replace data.  The first option only replaces the values
(dollars, text, days, etc.).  The fourth, remove option, deletes the entire sheet
including all accounts, labels, dollars, and cross-reference information and builds a
new sheet using only the information in the import file.  The system will warn you
before it actually deletes the existing sheet. 

The second and third import options add or subtract the incoming values to (or
from) the existing values in the AAI file.  These two options do not change the
existing cross-reference information. 
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You can choose to Print, Preview or Print to File the report.  You can also choose
Do Not Print.  

The following report shows an example of an Imported file into a .aaix file that did

not have any data.  You will notice that the Action column repeats Record Added. 

If the file had previous matching data, the Action column would read Record

Updated.  This report is very helpful when existing data is in place because it will

show Records that have been Added and may need further attention. 
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14.2 The Main AAI Screen

Your imported data will be displayed on the main AAI screen. 

If you did not import the cross-reference information, you can enter the Page, Part,
Program, Component, Line and Column information directly on this screen. You
can sort the Account screen on any column just by clicking on the column heading. 
The first click on a column heading will sort it into ascending order and the second
click will change it to descending order.  This can be very helpful if you have an
unexpected value on a particular line, you can sort by that line and find al the
accounts that contribute to that line. 

The system has the ability to store multiple .csv files in separate worksheets or
workbooks. These can be set up as you import or by clicking on the New
Workbook button on the AAI tool bar.  You can switch between workbooks by
clicking on the left-hand task pane tree and worksheets within the workbook by
clicking on the tabs at the bottom of the window. 

The Main Account Descriptions, Sub Account Descriptions and Unique Account
Descriptions can be viewed by clicking in the Left-hand task pane tree on
Accounts.  The Account Descriptions can be viewed on the main screen at the
bottom left of the screen individually as you scroll through your accounts. 
Descriptions can be edited on this screen. If you enter a unique line label, then that
label only applies to that specific account and sub account combination.  Unique
line labels can be edited and added using this screen.  When you enter or change
a unique line label, it only affects the one entry.  Unique labels can also be
imported. 
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There is a snap line (dotted line) between the left-hand task pane and the Account
View Window.  If you click on this snap line it will remove the task pane view and
allow the Account View Window to use the whole window.  Another click on the
snap line will restore the left-hand task pane. 

Accounts can be added by typing them at the end of your worksheet.  The account
descriptions can then be added on the Accounts listing.

 Accounts can be deleted by zeroing the account and sub account information on
the worksheet screen or by highlighting the line and choosing CTRL+X to cut it. 
The amount column can be cleared by highlighting the entire column and choosing
CTRL+X to cut the values.  If you are using the same cross-reference for multiple
providers, you can make a copy of the file and “Clear” all the values.  Then, when
you download the new provider’s data, it will not have any of the previous values. 
The same process can be applied to use last year's file for this year, make a copy
and “clear” the file. 

14.3 Sequence

The Sequence number gives you the ability to have the same Main Account and
Sub Account go to multiple places or to manually split the amount.  Utilizing the
sequence number, you can have two Worksheet, Part, Program, Component, Line
and Column references.  If you import a file that has a duplicate account/sub
account combination, but different cross referencing the system will change the
sequence code. 
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14.4 Manually Enter Cross-Reference Information

There are three ways to tell the system where your data should go in the cost
report.  The first is to enter your data on the AAI screen.  You can manually type
your entries into the Worksheet, Program, Component, Other, Line and Column
cells.  This sounds like a big job, but the system helps by repeating the above entry
with whenever you press Enter.  Usually, groups of accounts share most cross-
referencing information, so this process goes pretty quickly.  Also, this file can be
copied and used for the next facility's report or next year’s report so you will only
have to do the cross referencing once.

 

14.5 Import Cross Reference Information

When you import your data, you will be given the option to choose a format that
includes the cross-reference data in your import file.  The cross-reference data
must contain six components separated by commas:  Worksheet, Part, Program,
Component, Line and Column.  If the Worksheet does not have a Part, Program or
Component, enter zeros or have nothing between the commas.  As mentioned
before, entering the cross-reference data requires some familiarity with the
system.  If you are not sure what needs to go into the cross-reference Values,
again, go into a Workbook in the Automated Account Window and enter the
worksheet for which you will be supplying cross-reference data.

 

14.6 Assignment Rules

The third option is to use our Assignment Rules feature.  Most GL systems can
generate a list of accounts, sub accounts and the names of those accounts.  Not
all can generate the worksheet, part, program, component, line, and column where
the value belongs in the cost report.  To simplify this task, we added the
assignment rules capability. Let’s say that you have an overtime salary sub account
#123.  It is likely that this sub account occurs in 100 different departments. 
Instead of keying the cost report location 100 times, you generate a single
assignment rule that states for the range of expense accounts, every time you see
sub account #123, it goes to Worksheet A, column 1.  When you apply the
assignment rules, the system makes the 100 references for you. 

Perhaps this same accounting system has an account (or department) #654.  This
account has 100 sub accounts (expense classifications).  You would need to type
the cost report location 100 times.  Or you can type a single assignment rule that
says whenever you see department #654, put it on line 41 of the cost report. 
When you apply the assignment rules, the system makes the 100 references for
you. To access the Assignment Rules, click Assignment Rules in the task pane. 
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You can then enter or modify your rules in the Assignment Rules screen. If you do

not enter a value (like the line number field in the following example), this field will

not be completed for this rule when you Apply the rules.  Entering a good

description helps you recall what the rule does

Rules can be inserted by keying CTRL+I.  The order of the rules can be used to
make exceptions to an already existing and broad rule, as rules are applied in
sequential order. You can create a rule that affects a large range of accounts. 
Then add rules that replace the cross referencing for selected accounts. 

The previously depicted three icons on the Automated Account Interface tool bar
are for the Assignment Rules.  When you are finished creating or editing the
Assignment Rules you will click on the Apply Rules icon to have the assignment
rules fill in your cross-reference data on the AAI Account screen.  When you apply
rules, you will be able to specify which workbook and sheet the rules should apply
to. The Assignment Rules are stored in a file with an extension of .airx.  After you
have entered data you will save this file by choosing the Save AIR As icon. You
can choose the location and name of the file at this time. To select an existing .airx
or .air file, click the Load AIR button.  You can use the .airx file that you create for
your next year’s cost report, another facility with the same GL set up or share it
with another cost report preparer. 
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14.7 Statistics

The system has the ability to statistically distribute accounts.  The first step in this
process is to define the statistics to be used.  To add a statistic, click Statistics in
the left-hand task pane. On the Statistics Screen, you will see all the existing
statistics listed at the top of the window.    The bottom of the Statistics screen will
allow you to add a new statistic.  Type a new statistic code and a description of
the statistic.  The statistics code will be entered in the Basis column on the
accounts screen for those accounts to be allocated using that statistic. 

Once the statistic is defined, it must be entered.  When you define a new statistic,
you can either choose Cost Center based or User Defined.  The following screen
shows Cost Center based.  The amounts you enter on each cost center will be
used to allocate the account data to the lines. A running total is kept at the left. 

To modify a statistic, click its Code in the top of the window.  You can also right
click the statistic's Code and get the option to add a new statistic, delete a statistic
or import a statistic.  If you have statistics from a Prior Year or in another AAI file
you can click Import and bring them into this file. 
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14.8 Export

Click the Export button to export your data from the Automated Account Interface
to your cost report. 

When you export AAI data you will be able to specify which workbook and sheet to
export. Click to select the workbook and sheet.  If there is only one sheet in a
selected workbook, the sheet will be automatically selected when you select the
workbook. 

Click the Options button to configure the available options. 
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The first option allows you to not export accounts with zero amounts to the cost
report.  For this option you need to consider whether you already have data in the
cost report that you do not want replaced with zeros from the AAI file.  If you
choose to apply accounts with zero amounts, AAI will replace existing cost report
values with zeroes.  Some users have very large charts of accounts.  Individual
providers may not use many of these accounts.  We give you the option of not
applying the accounts that do not have any dollars. 

The second option allows you to reverse the sign on liability and revenue accounts.
 In a true trial balance, all revenue and liability accounts are negative.  In order to
get these into the cost report correctly, it is necessary to reverse the signs.  AAI
will reverse the sign if the destination field in the cost report is a revenue or liability
amount. 

The third option is the type of Action.  Chose to either replace existing cost report
data or add AAI data to any existing cost report data.  If you had sheets set up
with monthly or quarterly data and you imported them one at a time you would
choose Add because you would want your data to reflect the cumulative total of
the data of al sheets you imported.  If you were only using one sheet you would
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probably leave the default at replace. 

You can suppress the printing of the export report.  However, this report is one of
the primary advantages of the export.  The report is an audit trail showing you
which accounts went into each line and column and worksheet in the cost report.

The report is organized by cost report worksheet, i.e. A, B-1, C part I.  You can
choose to start a new page of the report each time you change worksheets.  The
report can be printed to your printer, previewed, or printed to a file. 

15 Batch AAI

We have many customers who use AAI to create multiple cost reports every year.
We recognized the need for a batch process that would eliminate the repetitive
steps required to create numerous cost reports, one at a time, using AAI.  We
developed Batch AAI.  Batch AAI will create any number of cost reports in a batch
process, using the AAI feature.  With Batch AAI it is possible to create many cost
reports all at once using the powerful AAI feature.

To start Batch AAI, open the File menu and select Batch, then click Batch AAI. 
The Batch AAI dialog box opens on your screen.
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In the Batch AAI dialog box you select the type of cost report files you want to
create in the batch process.  You can create only one type of cost report file
during a batch.  Then select any of the Cost Report Template Options.  You can
use a cost report file of the same type as a template.  You can do the same with a
339 file.  You can also select an AAIX and AIRX file to use as templates.  The cost
report  file and 339 template files will populate parts of your new cost report files
with the data in those template files.  The AIRX and AAIX templates allow you to
create a batch of cost reports based on the same set of assignment rules and
account structures.
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In the next dialog box you select a folder that Batch AAI will import data files from.
Alternatively, you can identify individual csv files to import data from during the
batch processing.  You also enter the output location for the files that will be
created in the batch.  Click Next when finished.
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The third step in the process requires you to select from predefined data formats
for the data to be imported into AAI, or if there are none that are appropriate you
have to define the name of the data format.
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After you click Next you will enter the details of your data import specification, just
as you would if you were using the regular AAI feature. When you are finished you
can click Save As to save the specification under a new name, or click Specs to
open another specification file. When you finish entering specifications, click Next.

The fifth step in the process is to select from the available options regarding how
the imported data will affect existing data.  Choose from the same four options
available in regular AAI.

When you click Next, the Batch AAI process will start and you will see the Batch
AAI Progress dialog box which shows the status and progress of each file
imported during the batch process.
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In the example shown above, the AAI import process was successful, except that
there was a Level I edit in the cost report file created, and therefore an ECR was
not created.  When this happens you would have to open the cost report and
resolve the condition that caused the Level I edit, recalculate the cost report and
export the ECR files.

See also:         AAI

 

16 Special Reports

All of the HFS Special Reports have been converted to worksheets.  Like other
worksheets, you can copy and paste, to or from these worksheets, as well as print
them to a file (just like any other worksheet). You can also Batch Print any of the
Special Reports (from the File menu point to Batch and select Print Batch.  
These reports are also accessible from the Print command on the File menu. (If
there is no input required, the report is calculated along with the rest of the cost
report, and can then be printed). Reports #910 and #920 require user input. Open
the reports by selecting Open from the File menu and select the Reports from the
list of all worksheets. Enter data in the Reports and then calculate the cost report.

The following is a detailed list and summary of the HFS Special Reports.
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Interns Residents (Bed/Census) Report, or SR #902 (see CMS Pub. 100-04,
Section 20.2.3) – This is used to compute the Intern to bed ratio for IME payments
and Capital IME (part of FISS).  This is run for audit/settlement purposes.  It may
also be used for interim payment calculations.  It is SR #902 in the list of
worksheets displayed in the Print Form dialog box, and can be printed.  To print
the report from the Print Form dialog box, select SR #902, at the bottom of the
worksheet list and click Print. You can also print to a file (PDF).

Long Term Care (RCC) Report SR #903 – P.M. A-02-093 and Change Request
#5202.  This can be used to compute Long Term Care hospital’s PPS payments,
and Outliers. This can be run at Tentative and Final Settlement for interim payment
purposes (FISS).  The I&R to Beds Ratio Report, the I&R to Average Daily Census
Ratio Report, and Medicaid Ratio, were incorporated in this report in 2/2007 to
consolidate all info on one Report, and to incorporate changes made to the short
stay outlier computation initiated in Pricer on 7/1/2006, per Change Request
#5202.  This includes the Bed Size and Average Length of Stay calculation
(ALOS), for this report. It is SR #903 in the list of worksheets displayed in the Print
Form dialog box, and can be printed by selecting SR #903 from the bottom of the
list and clicking Print.  You can also print to a file (PDF).

CAH Medicare Impact Report or SR #905 - This report calculates the Medicare
utilization (days to days), and applies this utilization factor to a determined impact
amount (Medicare Impact), to estimate the change in each cost center that would
result in Medicare Impact.   It is SR #905 in the FILE, Print menu, (File, Print, SR
#905 at the bottom of the list).  You can also print to a file (PDF).

Florida Medicaid Settlement Summary, SR #908 - This report has the special
attestation for Florida Hospitals, on the W/S S settlement summary page.  It is SR
#908 in the FILE, Print menu, (File, Print, SR #908 at the bottom of the list).  You
can also print to a file (PDF).

CAH Per Diem with Bad Debt, SR #909 - This similar to the SR #910, but
includes Bad Debt cost in the per diem calculation.  It is SR #909 in the FILE, Print
menu, (File, Print, SR #909 at the bottom of the list).  You can also print to a file
(PDF).

CAH Per Diem Report, or SR #910 - This report calculates the per diem for
Hospital, both Part A and Part B, as well as SW/Bed Part A and B.  It is SR #910
in the FILE, Print menu, (File, Print, SR #910 at the bottom of the list).  You can
also print to a file (PDF).

https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS018912
https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS018912
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Psych Rate Report SR #911 – Change Request #3541.  After the cost report is
calculated, click on Forms, Print, SR #911 (at the bottom of the list), and you can
Print or Preview the report.  This is the cost to charge ratio report for Psych
Hospitals or Subproviders, effective for FY Begin 1/1/2005 and after.  This
provides the RCC for the interim rate setting.  The I&R to Average Daily Census
Report was incorporated in this report to make all Psych info available in one
report, per Change request #3541. Use the Print Preview Icon to view/print the
Report.  You can also print to a file (PDF).

CAH 96 Hour Verification Report, or SR #913 - Used to verify the 96 hour
maximum stay for inpatients.  We use the actual hours on Worksheet S-3 part I,
column 4, but if these hours are “1” just to pass the edits, we also compute an
estimated length of stay by dividing days by discharges, and multiplying by 24
hours.  Use the Print Preview Icon to view/print the Report.  You can also print to a
file (PDF).

OPPS RCC Report (Excluding Paramed Ed and Allied Health cost), or SR
#916 - Change Request #5238 and P.M. A-03-004, is used to compute interim
TOPs Payments and Outpatient PPS outliers.  This is run for settlement and
interim payment purposes.  This Report replaced the OPPS RCC Report in
2/2007, as it is the same Report if there are no Paramed Ed costs.   It can be
printed (File, Print, SR #916, at the bottom of the list).    You can also print to a file
(PDF).

Cost to Charge (RCC) Report, or SR #917 – Change Request #3966.  This is
used to compute the acute care PPS Operating and Capital cost to charge ratios,
for Outliers; and DSH adjustment.  This is run at Tentative, and to Settle reports,
but may also be used to set interim payments, i.e. used to calculate the Medicaid
ratio for FISS, to pay DSH during the year.  You can Print (File, Print, SR #917, at
the bottom of the list) the report, or Preview it.  You can also print to a file (PDF).

Pass Through Per Diem Report, or SR #918 – This report computes the Allied
Health and Med Ed pass through costs, on a per diem basis.  It is SR #918 in the
32-bit system, and can be printed (File, Print, SR #918, at the bottom of the list). 
You can also print to a file (PDF).

Rehab Rate Report (formally Special IRF Report), and now SR #920 – P.M. A-
01-131 and Change Request #1921, #2978 (also see Pub.100-04, section
140.2.6). You can Preview or Print the SR #920.  We compute the Medicaid ratio
for LIP payment purposes.  MACs use this report to update the provider payment
history.  This can be run each time the report is ‘processed” (Tentative, Final,
Reopening). The I&R to Average Daily Census Report was incorporated in this

https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS018912
https://www.cms.gov/Regulations-and-Guidance/Guidance/Manuals/Internet-Only-Manuals-IOMs-Items/CMS018912
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report to make all Rehab info available in one report, and is per Change Request
#4037.  The Medicaid ratio was added to this report per Change Request #1851. 
Use the Print Preview Icon to view/print the Report.  You can also print to a file
(PDF).  We compute the Under/Over the Threshold amounts, and then transfer this
Under/Over to the Acceptability Checklist.

HITECH FISS Data Report, or SR #921 - This report displays the days,
discharges, charges, and charity care, and cost of EHR equipment, for both CAH
and Non CAH hospitals. This data is to entered in FISS within 5 days of
acceptance.

HITECH FISS Data Report, Finalized Report or SR #922 - This report is the
same as SR #921 but used by the MACs just for cost reports that are NPR'd.  This
report displays the days, discharges, charges, and charity care, and cost of EHR
equipment, for both CAH and Non CAH hospitals. This data is to entered in FISS
within 5 days of acceptance.

IRIS to Cost Report Validations, or SR #923 -  

 

17 File Extensions

Extensio
n

Description Do you need
this file?

.MCRX Data file for 2552-10, 2540-10 and 265-11 cost reports. Yes

.MCR Data file for Medicare cost reports (2552-96, etc.) Yes

.CLTX Data file for California Long-Term Disclosure Report file
(LTCIRX)

Yes

.CLT Data file for California Long-Term Disclosure Report file
(LTCIR)

Yes

.CDRX Main data file for California Hospital Disclosure Report
file (CHDRX)

Yes

.CDR Main data file for California Hospital Disclosure Report
file (CHDR)

Yes

.MCRX.fs~ Temporary file. Yes, if the cost report
file is open.

.TMP Temporary storage file created during calculate Recommended

.TXT/.PDF Text files or Adobe PDF file format, created if you
select Print to File

No

.DAMAGE
D

Created by Restore/Reorganize tool No, this is a
damaged file.
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.BPL Program File for HFS software Yes

.DAT Data file for error descriptions Yes

.LBL Temporary label file No

.RAV Report formatting file for the HFS software Yes

.UPDATED Information file for updates No

          Acceptability Checklist

.ACC Associated with Acceptability Checklist Yes

         Auditor Extensions

.MCA, .MC
AX

Adjusted cost report file; contains audit adjustments
applied in Auditor

Yes, if using
Auditor

.TMA Temporary storage file for MCA file; created during
calculate

Recommended

.Auditor Stores audit adjustments used in Auditor Yes, if using
Auditor

.Auditor.BK Auditor backup of adjustments Yes

        Automated Account Interface Extensions

.AIRX Stores all assignment rules Yes

.AAIX Contains account, amount, and cross-reference
information

Yes, if using AAI

        339 Extensions

.XPRQ Main data file that contains 339 information Yes, if you are
using 339

        Management Reports

.255210mr
x

Management report groups and global tolerance criteria Yes

        PS&R Extensions

.MCP Contains all PS&R information Yes

.XRD PS&R file Yes

        Data Extractor

.CSDX Contains specifications of data to be extracted Yes

.CSV Comma separated file Yes

.DSC Batch Data Extractor Specification Criteria file Keep/delete - user
generated

.DSS Batch Data Extractor Specification file Keep/delete - user
generated

        Professional Desk Review

.PDRX Data file Yes

.PDTX Template file Yes

        Wage Index

.WIC Data file Yes

.WIT Template file Yes
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18 Introduction to API

Overview of the HFS Application Programming Interface 
The HFS Application Programming Interface (API) is a set of functions made
available to external programs to allow those programs a way to communicate with
the HFS Medicare Cost Report (MCRIF32) software. This communication is
performed through a structured command language that tells the MCRIF32
software what type of tasks to perform. Commands can be sent to extract specific
worksheet data, to write specific worksheet data, or to perform operations such as
printing reports. 

Purpose 
The purpose of the API is to assist in the automated processing cost report data
through user defined tools without the need to open the MCRIF32 software or use
the graphical user interface (GUI) of that software. This allows your staff, even
with minimal programming knowledge, a powerful mechanism for cost report data
mining. 

Capabilities 
Listed below is a list of capabilities built into the API as of 03/05/2021: 

Data Extraction – Commands can be sent to the API to extract data from
specific worksheets within the cost report. You can extract data from one
or more worksheets and from any number of fields on those worksheets,
all with a single command. 
Data Push – Commands can be sent to the API to push data to specific
worksheets within the cost report. As in data extraction, you can push data
to one or more worksheets and to any number of fields on those
worksheets, all with a single command. 
Multiple File Processing – The API command language allows for multiple
files to be acted upon with a single command request. Using this feature
provides for faster processing when requesting same data from a large
number of cost report files. 
Worksheet Field Information – Commands can be sent to the API to
request all known field information in addition to extracting the value of the
worksheet field. This type of information is useful when you need to know
how the data might be formatted. For example, if the field is a date, the
API will return date information about the field such as our acceptable date
range and date formatting (i.e., mm/dd/yyyy). 
Cost Centers and Statistical Basis – Sending a cost center command to
the API will return the cost centers and statistical basis information for the
cost report. Cost center information includes the Worksheet A1 line number,
cost center code and cost center label. Statistical basis information
includes the overhead cost center column number (Worksheet B-1) and
statistic code statistic label for that column.  
Basic File Information – Commands can be sent to the API to retrieve
basic information about the files available. Once you extract a list of the
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files available, you can then tell the API to give you information about one
or more of those files. The information returned gives the provider name
and number, fiscal year begin and end dates, and whether or not the file is
calculated.
Edits Summary Information – Commands can be sent to the API to
retrieve a summary of the cost report Edits. The information returned gives
a list of total number of Edits for each level. 
Available Files List – The administrator of the API can control what files
will be exposed to the API. When this list is controlled, the API end user
cannot add to the list of files available to the API but can query a list of
those files so they can start building their requests. This approach is useful
when you want to limit the file set that can potentially be modified by users
of the API. · ECR Import – API has the capability to import ECR files and
print ECR import reports. · Auditor – Commands can be sent to the API to
create Auditor adjustments. 

Extraction Formats 
Because our clients use our data differently, different file output formats have been
requested for the API to produce2. 

Comma Separated Value (CSV) – This is a standard format supported by
almost every spreadsheet manufacturer. Each field is surrounded by
double quotes (regardless of data type) and separated by a comma from
other fields.
Look-up CSV – This format is similar to the standard CSV format with the
exception that some fields are combined into a “look-up” format that is
useful when developing queries using Microsoft Excel.
Extensible Markup Language (XML) – This format is a very flexible text
format designed to transfer large amounts of variable type data in a way
where that data can be easily extracted. This format follows the W3C
specifications. To use this format, more programming knowledge is
required of the API end user; however, the resulting data typically contains
more information than the CSV formats.

 Footnotes:
1 All worksheet references are for the CMS-2552-10 cost report form set.
2 Refer to the API technical documentation for output layout and examples. 
3 See http://www.w3.org/XML/ for more information.

API Layout Overview 
The following is an overview of where the API fits into the realm of the end user
program and the MCRIF32 software:
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Specifications:

The HFS API has the following functions currently available:

procedure GetFileList(ret: LPWSTR); stdcall;

procedure GetFileListA(ret: LPCSTR); stdcall;

procedure GetMCRData(instructions: LPWSTR; ret: LPWSTR); stdcall;

procedure GetMCRDataA(instructions: LPCSTR; ret: LPCSTR); stdcall;

and some test functions:

procedure TestGetMCRData(instructions: LPWSTR; ret: LPWSTR); stdcall;

procedure TestGetMCRDataA(instructions: LPCSTR; ret: LPCSTR); stdcall;
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GetFileListA, GetMCRDataA and TestGetMCRDataA functions have been added
to support regular string types.

TestGetMCRData and TestGetMCRDataA are for testing purposes, any text can
be passed as instruction, the returned

value is:

“API TestGetMCRData - instructions received!” if a text (any text) has been
passed to it and

“API TestGetMCRData – no instructions were passed” if no instructions were
passed.

As part of the above message you also get the size of the allocated memory by
the calling program for the “ret” result.

 

Capabilities:

Currently the API can operate on Cost Report files in several ways:

·  Can process multiple files in one single request

·  Ability to select 3 different type of data output format: XML, CSV and Lookup

·  Can “read” data and return the result in one of these formats: XML, CSV,
Look up

·  Can retrieve data including line and column labels

·  Can retrieve the worksheet list used by a specific sub-system, can also
retrieve component and title lists

·  Can retrieve Cost Report file basic information

·  Can query data returning characteristics of the type of data along with the
data itself

·  Can “write” to the Cost Report file with Add or Replace value type of action

 
The following are examples of commands that may be used to accomplish typical
tasks using the API.
 

-         <outputspecs output="CSV"/>  3 different type of data output formats:
XML, CSV and Lookup

-         <read id="A000000"> Read data returning the result in one of the
above formats

-         <read id="A000000" type="alllabels"> Retrieve data including line and
column labels

-         <read id="costcenters"/> Retrieve cost centers and statistical basis

-         <read id="reclassifications"> Can retrieve reclassification code list and
all data
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-         <read id="worksheetsex"/> Retrieve the worksheet list used by a
specific sub-system

-         <read id="components"/> Retrieve the component list used by a
specific sub-system

-         <read id="programs"/> Retrieve the program list used by a specific
sub-system

-         <read id="worksheetstatus"/> Retrieve the open worksheet list

-         <query id="A000000"> Query data returning characteristics of the
type of data and values

-         <write id="A000000"> Write to the Cost Report file with Add or
Replace value type of action

-         <command id="edits"/> Retrieve current Edits summary

-         Can process multiple files in one single request:
<files>
  <file type="2552-10" instruction="managementreports"><![CDATA[C:\Data
\new1.mcrx]]></file>
</files>

-         Can retrieve Cost Report file basic information:
  <property name="filelabel"><![CDATA[C:\Data Files\2552-96\F.mcr]]></
property>
  <property name="calculated">false</property>
  <property name="fyb">01/01/2008</property>
  <property name="fye">12/31/2008</property>
  <property name="provider"><![CDATA[CHILDRENS RECOVERY
CENTER]]></property>
  <property name="providerNo">09990</property>

The following code snippets illustrate methods of programmatically instructing API
to perform certain useful tasks.  the following example illustrates a sample call
from a Client program.
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This next example retrieves MCR data and a list of files.
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The next code snippet retrieves a list of files from Excel.
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The following picture shows a sample XML file containing data retrieved by API
from cost reports.

 

API can selectively retrieve data. This example retrieves cost centers and statistics
from the cost report.
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API can query the cost report data file and return data and return specific
characteristics of the data elements it retrieves.
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There are too many potential uses for API for us to show examples of all of them. 
This tool is incredibly useful and is already installed with your cost report software.
 If you are interested in using API and you need help writing commands for API,
please contact our technical support staff for assistance.
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18.1 API Excel Spreadsheet

Used for both writing data to and extracting data from the cost report

Able to create adjustments to the .Auditor file

Works with a number of HFS systems:
• Hospital 2552-10 & 2552-96
• Skilled Nursing Facility 2540-10 & 2540-96
• End Stage Renal Disease 265-11 & 265-94
• Organ Procurement Organization 216-94
• Home Health Agency 1728-20 & 1728-94
• Rural Health Clinic 222-17 & 222-92
• Federally Qualified Health Clinic 224-14
• Hospice 1984-14
• CMHC/CORF 2088-17 & 2088-92
• Home Office 287-22 & 287-05
• California Hospital Disclosure Report (CHDR) HCAI Report
• California Long Term Care Integrated Report (LTCIR) HCAI Report

HFS API Excel spreadsheet can be found on our website, www.hfssoft.com, in the
Download Center

18.1.1 Downloaded/Blank Spreadsheet

The Downloaded spreadsheet will look like this: 

Four tabs at the bottom

http://www.hfssoft.com
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Results tab shows the results of what was extracted from the cost report
and also fives a quick overview of what was written into the cost report
API Extract tab this is where specs are laid out identifying what data will
be extracted from the cost report file
API Write tab this is where specs are laid out identifying what data will be
written to the cost report file
Auditor Setup tab is where adjustments are entered. The adjustments will
create a .Auditor file if one does not already exist. Otherwise, adjustments
will be added to an existing .Auditor file

18.1.2 Explaining the buttons –API Extract tab

System
This is a drop-down list where the system being worked with is selected

Data File 1-4 location
• By selecting the Browse button you can select one or as many as four
HFS cost reports
• Extracting data for more than one year can help establish trends and
comparing 

MCRIF32 Location
• Default is to the local c drive
• If your MCRIF32 folder is not located at this location, please change the

data path by clicking on the MCRIF32 Folder button and navigating to your
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MCRIF32 folder 

Output Sheet
• Where extracted data will be placed
• Refers to the Results tab at the bottom of the Workbook
• If you decide to rename the Results tab, you will also need to change the
Output Sheet text box to have the exact same name

Update
• Updates your API Excel spreadsheet
• When a Help | Check for updates is performed in the HFS software, a file

will be placed into your MCRIF32 folder (this is why it is important to have
the MCRIF32 Location properly setup)

• If there is an update, the next time the API Excel spreadsheet is opened a
notification will prompt you that an update is available

Extract from File
• Will take the specs listed on this tab, extract the data from 1-4 HFS cost
reports and present the data on the results tab
• Add a VLOOKUP to your workpapers and the API Excel spreadsheet will

not only grab data from the cost report, but then populate your
workpapers with this information
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Pick ECR ID
• Helps to fill out the spreadsheet below telling the API which worksheet
needs data to be extracted from

Column Headings
• WKS ECR column comes from the Pick ECR Id button. This format is not
necessarily something you might recognize
• Worksheet column comes from the Pick ECR ID button but is in a more
user friendly/recognizable format
• Program column comes from the Pick ECR Id button when a program is
available for the selected worksheet
• Component column comes from the Pick ECR Id button when a component
is available for the selected worksheet
• Line column specifies which line data will be extracted from
• Column column specifies which column data will be extracted from
• Other column is used for reclassifications
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18.1.3 Explaining the buttons –API Write tab

System
This is a drop-down list where the system being worked with is selected

Data File 1 location
• By selecting the Browse button you can select one HFS cost report

MCRIF32 Location
• Default is to the local c drive
• If your MCRIF32 folder is not located at this location, please change the

data path by clicking on the MCRIF32 Folder button and navigating to your
MCRIF32 folder 

Output Sheet
• Where extracted data will be placed
• Refers to the Results tab at the bottom of the Workbook
• If you decide to rename the Results tab, you will also need to change the
Output Sheet text box to have the exact same name
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Update
• Updates your API Excel spreadsheet
• When a Help | Check for updates is performed in the HFS software, a file

will be placed into your MCRIF32 folder (this is why it is important to have
the MCRIF32 Location properly setup)

• If there is an update, the next time the API Excel spreadsheet is opened a
notification will prompt you that an update is available

Write to File
• Will take the specs listed on this tab and write it into the specified cells on
the HFS cost report
• This button can take all the total numbers from your standardized
workpapers and input it all into the specified cost report

Show Results After Write
• If checked, after the Write to File button is clicked you will be taken to the
results tab
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• Shows the values that were written to the cost report

Pick ECR ID
• Helps to fill out the spreadsheet below telling the API which worksheet
needs data to be extracted from

Create New File
• If there is not an existing file to write data to, the Create New File button
will allow you to create a blank file and write the data to it

Column Headings
• WKS ECR column comes from the Pick ECR Id button. This format is not
necessarily something you might recognize
• Worksheet column comes from the Pick ECR ID button but is in a more user
friendly/recognizable format
• Program column comes from the Pick ECR Id button when a program is available
for the selected worksheet
• Component column comes from the Pick ECR Id button when a component is
available for the selected worksheet
• Line column specifies which line data will be written to
• Column column specifies which column data will be written to
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• Write Value column is what data is to be put into the cost report
• Other column is used for reclassifications
• Other Desc. Column is used to write a reclassification description

18.1.4 Explaining the buttons –Auditor tab

System
This is a drop-down list where the system being worked with is selected
Only the Hospital 2552-10 and SNF 2540-10 systems are currently
available

Data File 1 location
• By selecting the Browse button you can select one HFS cost report

MCRIF32 Location
• Default is to the local c drive
• If your MCRIF32 folder is not located at this location, please change the

data path by clicking on the MCRIF32 Folder button and navigating to your
MCRIF32 folder 

Create Adjustment
• Will create the specified adjustments into an existing .Auditor file or create
a new one if one does not already exist
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• Adjustments made on the spreadsheet will NEVER override any existing
adjustments in the .Auditor file
• If the Adjustment No. column is left blank, then the adjustment will append
to the end

Pick ECR ID
• Helps to fill out the spreadsheet below telling the API which worksheet
needs data to be extracted from

Column Headings
• WKS ECR column comes from the Pick ECR Id button. This format is not
necessarily something you might recognize
• Worksheet column comes from the Pick ECR ID button but is in a more
user friendly/recognizable format
• Program column comes from the Pick ECR Id button when a program is
available for the selected worksheet
• Component column comes from the Pick ECR Id button when a component
is available for the selected worksheet
• Line column specifies which line data will be adjusted
• Column column specifies which column data will be adjusted
• Value column is the data that will be written as the adjustment 
• Action column is the action that the adjustment will have on the adjusted
cost report
• Adjustment No. column specifies which main adjustment this adjustment will
attach to
• Workpaper column fills in the Workpaper text box in the Medicare Auditor
tool
• Notes column fills in the Notes text box in the Medicare Auditor tool
• Other column is used for reclassifications
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19 IRIS

HFS received CMS approval for our newest cost report software product, the
Interns & Resident Information System (IRIS).  Most providers have been using the
old, outdated, DOS based IRIS software for many years.  The DOS software has
not changed in many years and it has not kept pace evolving operating systems or
software development trends.  Our IRIS software is a Windows application.  It can
do everything the old software did and more, and it does everything better that the
old program you've been using all these years.  There is a separate user manual
dedicated to the IRIS program.  Please contact HFS if you are interested in
licensing our new IRIS software.

 

See also:        IRIS product page

 

20 HCRIS Analysis Tools

Please see HCRIS product page on the HFS website.  There is a separate user
manual for this product that can be downloaded from the website.

HCRIS product page

21 Wage Index Verify

The Wage Index Verification tool was initially created to help MACs verify submitted HCRIS
data against the actual cost report files used to submit that HCRIS data. The Wage Index
Verification feature is started by clicking Wage Index Verification on the Tools menu.
Specify the folder with the HFS Comma Separated (CSV) files reflecting the CMS Public
Use File (PUF) that you have downloaded from  www.hfssoft.com/.  Then specify the folder
where the cost report files you wish to compare to the PUF are located.

21.1 Using the Wage Index Verification Tool

The Wage Index Verification feature will examine the data in the CMS PUF file and

compare that data to the actual cost report files.  To do this, follow these simple steps.

1. Download the HFS CSV files reflecting the CMS PUF file from www.hfssoft.com.

https://www.hfssoft.com/doc/HFS%20IRIS%20SQL%20User%20Guide.pdf
https://www.hfssoft.com/doc/HCRISWebManual.pdf
http://www.hfssoft.com/
http://www.hfssoft.com
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2. Decide which folder will contain all of your cost report files and copy those files to that

folder. Note: It’s okay for the folder to contain sub-folders with cost report files. Also, the

cost report files can be either .mcr, .mcrx, .mca or .mcax files.

3. Start the Wage Index Verification by clicking Wage Index Verification on the Tools

menu. You will see the following screen:

4. Note that separate CSV files have been created for FY 2014 files that were filed on Form

2552-96 and Form 

    2552-10. The wage index verification will have to be run separately for files submitted on

Form 2552-96 and Form 2552-10. Select the appropriate form set in the “System” drop

down box.

5. Type the name of the HFS CSV file you downloaded in #1 above. You may also press

the Browse button to browse for the file.

6. In the Cost Report Folder box, type the name of the folder where your cost report files

are located. This should be the same folder you decided upon in step #2 above. You

may also press the Browse button  to browse for the desired folder.

7. If you created sub-folders and those folders contain cost report files you want to search,

place a check mark in the box labeled Include sub-folders  in cost report file search.

8. Entering a MAC number will increase the speed of the report generation by limiting the

data for review.  Enter the MAC Number if available or check the “Do not check MAC

number” box.

9. When you have finished with the above steps, click the Run button.

10.The Wage Index Verification software will print preview the results of the verification
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process.  On the preview screen, you can move through each page by pressing the Next/

Prev buttons. When you are ready to print, press the Print button.

11.To close the Wage Index Verification software, press the Cancel button on the Wage

Index Verification software’s main screen.

Wage Index Verification Report

The headings on the Wage Index Verification Report contain the software version, date and

time prepared, the section title and the fiscal year begin date range for the data being

verified. This date range is determined from the PUF data you provided to the software. At

the foot of each page is the HCRIS data file used and the page number.

There are four different sections on the report: 

HCRIS DIFFERENCES FOUND

This section contains all of the differences found between the HCRIS data (PUF) and the

actual cost report file.  Ordered by provider number, this section shows the provider name,

number, fiscal year, and any differences found. These differences are ordered by

worksheet and line number on that worksheet.  If no differences are found for any provider,

the message NO DIFFERENCES FOUND will be printed in this section.

SUMMARY OF COST REPORT FILES USED FOR COMPARISONS

This section shows the cost report files that were used for the data comparisons. Ordered

by provider number, this section shows the provider name and number, and the cost report

file used to compare against the HCRIS data.  This section will help you locate the correct

cost report file when you are researching any differences the system may have found.  If,

for some reason, no cost report files could be matched to your HCRIS data, the message

NONE FOUND will be printed in this section.

COST REPORT FILE PROCESSING ERROR

This section shows the cost report files that were matched to a provider in the HCRIS data

but could not be properly processed when the system tried to verify that HCRIS data.

Ordered by provider number, this section shows the provider name and number, and the

cost report file that caused the processing error.  This section will help you determine if all
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of the HCRIS data was properly processed.  If any files show up in this section, reboot your

computer and run the Wage Index Verification software again.  If you continue to have files

show up in this section, call us so we can determine the problem.  Ideally, nothing will show

up in this section and you will see the message NONE FOUND.

DATA WITHOUT A MATCHING COST REPORT FILE

This section contains all of the HCRIS data that could not be matched to a cost report file. 

Ordered by provider number, this section shows the provider name, number and fiscal year.

 If all of the HCRIS data were matched to cost report files, the message NONE FOUND will

be printed in this section. This section may help you determine which cost report files you

need to move into the folder that contains the cost report files you want used for the HCRIS

wage index verification.  This section will not be completed if the “Do not check MAC

number” box was checked.
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